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Live Services Management

RSA NetWitness Live is the gateway to a rich environment that offers access to feeds, tools, and other
resources.

NetWitness Live

Live is the component of NetWitness that manages communication and synchronization between
NetWitness services and a library of Live content available to NetWitness customers. Live provides a
simple interface for browsing, selecting, and deploying content from the NetWitness Live Content
Management System to NetWitness services and software. In addition to managing feeds from the CMS
Library, Live allows users to deploy custom feeds and packages.

Note: Any customer with valid maintenance can access RSA Live.

The content management system (CMS) library (known as Live) is a valuable source of the latest
internet security resources for NetWitness customers. It provides a view into the collective intelligence
and analytical skills of the worldwide security community to ensure that users have the most current
visibility into attack vectors.

Live gathers the best advanced threat intelligence and content in the global security community - the
ideas, research, ongoing tracking, and analysis - and brings it directly into the user’s security operations
center to definitively classify computers associated with botnets, malware, and other malicious exploits.
Live aggregates, consolidates, and illuminates only the most pertinent information relevant to an
organization on a real-time basis.

NetWitness Feedback and Data Sharing

Live Feedback is intended to help improve NetWitness. Once you set up and configure a Live account,
usage data is shared with RSA.

For more details, see NetWitness Feedback and Data Sharing.

For Debian Linux and NetWitness Endpoint Users

If you are upgrading to NetWitness 11.5 or later, and you are using NetWitness Endpoint and also have
any Debian Linux endpoint systems, NetWitness recommends that you go to Live and download the
following application rules:

 autorun debian package mismatch

 autorun file path not part of debian package

e debian package hash mismatch in important system directory

* debian package hash mismatch

« file path not part of debian package in important system directory
e file path not part of debian package

7 Live Services Management
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Deploy Content

This section explains the different ways available to deploy content:

e Deploy Content using Live Content Ul

e Policy-based Centralized Content Management

Deploy Content 8
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Create Live Account

Note: The NetWitness Live Registration Portal now has a new user interface and supports email
verification.

You must create a Live account using the NetWitness Live Registration Portal
(https://live.netwitness.com/registration) on the Live server. Live Account is required to access all Live
services including CMS. The CMS Library provides access to all NetWitness content in one place where
you can view, search, deploy, and subscribe to NetWitness content.

Create Live Set up Live Find/Deploy Manage Live
Account Services Live Resources Services

(Optional)
Configure Feedback
& Data Sharing

Search/Download
Live Content

Make sure the following are available to set up a NetWitness Live account:

e Active internet connection to access the portal.
e A valid and registered NetWitness License Server on the Flexera Server, before you can register for a

a4
Live account. You can view the License ID on the (Admin) > System > Info panel.

Note: If the License Server is not set up, contact NetWitness Customer Support.

To create a Live Account:

1. Access the NetWitness XDR Cloud Services Live Registration Portal using
the URL: https://live.netwitness.com/registration

The NetWitness XDR Cloud Services Live sign up page is displayed.

9 Deploy Content
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NETWITNESS

Sign in with your username and password

Password *

Username *

SIGN IN SIGN UP FORLIVE

2. Click Sign Up For Live.
The End User License Agreement page is displayed.
Read the Terms and Conditions carefully and click Accept.

Welcome to RSA Live Registration Portal

Thank you for using RSA NetWitness.
Please sign up here for your RSA Live account to access your subscription content.

End User License Agreement

THIS SOFTWARE CONTAINS COMPUTER PROGRAMS AND OTHER PROPRIETARY
MATERIAL AND INFORMATION, THE USE OF WHICH IS SUBJECT TO AND EXPRESSLY
CONDITIONED UPON ACCEPTANCE OF THIS END USER LICENSE AGREEMENT (THE
“AGREEMENT").

THIS AGREEMENT IS A LEGALLY BINDING DOCUMENT BETWEEN YOU (MEANING
THE INDIVIDUAL PERSON OR THE ENTITY THAT THE INDIVIDUAL REPRESENTS
THAT HAS OBTAINED THE SOFTWARE AND HARDWARE FOR ITS INTERNAL
PRODUCTIVE USE AND NOT FOR OUTRIGHT RESALE) (THE “CUSTOMER”) AND
NETWITNESS (WHICH MEANS (1) RSA SECURITY LLC, IF CUSTOMER IS LOCATED IN
THE UNITED STATES, MEXICO OR SOUTH AMERICA; (ll) THE LOCAL NETWITNESS
SALES AFFILIATE, IF CUSTOMER IS LOCATED OUTSIDE THE UNITED STATES, MEXICO
OR SOUTH AMERICA AND IN A COUNTRY IN WHICH NETWITNESS HAS A LOCAL
SALES AFFILIATE; OR (Ill) RSA SECURITY & RISK IRELAND LIMITED OR OTHER
AUTHORIZED NETWITNESS ENTITY AS IDENTIFIED ON THE NETWITNESS QUOTE
OR OTHER NETWITNESS ORDERING DOCUMENT, IF CUSTOMER IS LOCATED

OUTSIDE THE UNITED STATES, MEXICO OR SOUTH AMERICA AND IN A COUNTRY IN
WHICH NETWITNESS DOES NOT HAVE A LOCAL SALES AFFILIATE). Unless
NetWitness agrees otherwise in writing, this Agreement governs Customer's use of the
Software and Hardware, except to the extent all or any portion of the Software or
Hardware is: (a) the subject of a separate written agreement set forth in a quotation

ACCEPT

3. In the Sign Up for NetWitness Live Account page, enter all the fields:
¢ The First Name and Last Name of the user.
¢ The Company for which the Live Account is being created.
¢ The Email address you enter will be used to receive the verification code for your new Live
account and other notifications related to the Live account.
The License ID can be viewed on Kl (Admin) > System > Info panel.

¢ The Username and Password for the Live Account.

Deploy Content
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NETWITNESS

Sign Up for Netwitness Live Account °

Company

First Name

Last Name

License ID

Username
|

Password

CREATE ACCOUNT

4. Click Create Account.
You will be directed to Confirm Sign up page.

5. Enter the Confirmation Code sent to your registered email address.

Click Confirm.
You can see the confirmation message for your NetWitness Live Account registration.

Note: You cannot create more than one Live account for the same License ID. For additional
license, contact NetWitness Customer Support .

6. Once the account is created, enter your credentials and click Sign In to access the NetWitness XDR
Cloud Services Live.

7. After you sign in, you can perform the following:

¢ Search and Download Content from NetWitness XDR Cloud Services Live

¢ Share Telemetry Data to NetWitness

11 Deploy Content
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Reset the Password for Your Live Account

If you want to reset the password for your Live Account, do the following:

1. Access the NetWitness XDR Cloud Services Live Registration Portal using the URL:
https://live.netwitness.com/registration

The NetWitness XDR Cloud Services Live sign up page is displayed.

NETWITNESS

Sign in with your username and password

Username *

Password *

SIGN IN SIGN UP FOR LIVE

2. On the Sign Up page, click Forgot Password?.

3. Enter your Username and click Send Code.
A verification code will be sent to your registered email address.

4. Enter the Verification Code and New Password on the Reset Password page and click Submit.

Deploy Content 12
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Set Up Live Services on NetWitness

To set up Live on NetWitness, you configure the connection and synchronization between the CMS

<4
server and NetWitness. The user interface for this setup is the (Admin) > System > Live Services
Configuration panel.

Create Live Set up Live Find/Deploy Manage Live
Account Services Live Resources Services

(Optional)
Configure Feedback
& Data Sharing

Search/Download
Live Content

To configure the connection to the CMS Server:

Q
1. Navigate to (Admin) > System > Live Services.

2. Click Sign In and enter your credentials in the Live Services Account dialog box.

Live Services Account

cms.netwitness.com

Port 443
55l 4
Username admin
Password S T T T TS

Test Connection

3. Click Test Connection to make sure your connection is working.

13 Deploy Content
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4. If the test is successful, click Apply. If not, contact NetWitness Customer Support for help
connecting to the Live server.

5. Configure the timing for synchronization of NetWitness with updates from Cloud Services Live.

For more details, see the "Configure Live Services Settings" topic in the System Configuration Guide.

Deploy Content 14


https://community.netwitness.com/t5/support-information/how-to-contact-netwitness-support/ta-p/563897

Live Services Management Guide

Deploy Content using Live Content Ul

This topic explains the process of deploying the content using Live Content UI.

e Live Services Required Procedures

e Additional Procedures

e References

e Troubleshooting Live Services

15 Deploy Content
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Live Services Required Procedures

The following workflow describes the basic setup into four steps, which you perform individually.

Create Live
Account

Search/Download
Live Content

Configuration Step

Create Live Account

Set Up Live Services on
NetWitness

Find and Deploy Live
Resources

Manage Live Resources

Search and Download
Content from NetWitness

XDR Cloud Services Live

NetWitness Feedback and

Data Sharing

Find/Deploy
Live Resources

Manage Live
Services

Set up Live
Services

(Optional)
Configure Feedback
& Data Sharing

Create a Live Account on the Cloud Services Live Registration portal
URL: https://live.netwitness.com/registration. If you have an existing
account, you can manage your account using this portal.

Set Up Live Services on NetWitness by configuring a connection with
the CMS server.

Search and browse for resources in the Live Search view, and then,
deploy the selected resources.

Procedures for administrators to search for, subscribe to, and deploy
resources from Live.

Search and browse for content in the Cloud Services Live, and then,
download the selected content.

Describes the feedback and data sharing features provided in NetWitness,
from Live Services. Participation is optional, but can help to provide
useful threat intelligence for the community.

Deploy Content
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Find and Deploy Live Resources

Administrators can search for resources in the Live Search view, which is also the same as browsing the
Live CMS for resources using the Search Criteria panel of the Live Search View.

Create Live Set up Live Find/Deploy Manage Live
Account Services Live Resources Services

(Optional)
Configure Feedback
& Data Sharing

Search/Download
Live Content

Find Resources in Live

To find resources:

1. Navigate to (Configure) > Live Content.

2. In the Search Criteria panel, specify search criteria. Enter any or all of these: keyword, category,
type of resource, medium, meta keys, meta values, date resource was created, and date resource was
modified.

Search Criteria

Keywords

Category
[IFEATURED
» CITHREAT
» CIIDENTITY
b [ ASSURANCE
» CTOPERATIONS

Resource Types

Medium

Required Meta Keys

Generated Meta Values

Resource Created Date:

Start Date End Date

Resource Modified Date: v

17 Deploy Content
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3. Click Search.
The Matching Resources panel displays detailed results.

.»’{‘.' NETWITNESS Investigate Respond Users Hosts Files Dashhoard Reports admin v
LIVE CONTENT SUBSCRIPTIONS CAPTURE POLICIES INCIDENT RULES INCIDENT NOTIFICATIONS ESA RULES CUSTOM FEEDS LOG PARSER RULES
Search Criteria Matching Resources
Keywords Show Results = | | % Package ©
malware .
By Malware Domains
Category - Feed 2017-07-19 1:02 AM 0.869 yes
[ FEATURED

List of domains associ vith malware sourced from v aredomains.com.

» ] THREAT @ threat, malw reat.category, threat.desc, thr: malwaredomains.com
» O] IDENTITY §
By Malware Domain List
» [0 ASSURANCE i Feed 2017-07-17 12:40 AM 01490 size 85.91 KB no
» [ OPERATIONS List of domains commonly a ted with malware sourced from www.malwaredomainlist.com

@ threat, malware # threat.category. threat.desc, threat.sourc malwaredomainlist-domain
Resource Types

~ Ry Malware IP List

Feed 2017-07-17 12:45 AM 0.1567 32.55KB yes

M "
Vedium List of ip addresses commenly associated with malware sourced from www.malwaredomainlist.com.

@ threat, m e £ threat.category, threat.desc, threat.sol

waredomainlist-ip

Required Meta Keys alware PDF

arser 2012-02-09 4:51 PM 0.1 17.51 KB no

;2 Intended only for 9.8. For SA deployments version 10 and above, see lua parser fingerprint_pdf_lua Detects PDF files that contain
pt or launch actions

m 57 Matching Resources

4. (Optional) To further narrow the results In the Matching Resources panel, click on a tag, meta key,
medium or resource meta value in a result.

Generated Meta Values v

Deploy Resources in Live

In NetWitness, you can deploy selected resources manually, using the Deployment Wizard, or you can
subscribe to a group of resources.

e When you have results from browsing resources in NetWitness Live, you can deploy resources

manually to a service or a service group without subscribing to the resources. To deploy resources,
select one or more from the list.

* Deploying resources manually deploys to services without taking advantage of the powerful resource
management capabilities of NetWitness. If you want to receive notification and updates for updated
resources and be able to easily remove resources from a service, you must subscribe to resources in
the Live Search view and deploy them in the Live Configure View.

» If you have previously created and saved a resource package, you can deploy the package to services.
Please refer to Resource Package Deployment Wizard for instructions on how to create a package.

Caution: For NetWitness 11.3, there is a new Content bundle for Endpoint, which contains
approximately 400 application rules. Do not deploy this bundle (or the Endpoint application rules) onto
any Log Decoder that is running an earlier version of NetWitness. The rules are only useful for 11.3
and newer, and would have major performance implications if deployed on Log Decoders that cannot
process them.

Deploy Content 18
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To deploy resources manually:

1. Goto (Configure) > Live Content.
2. Select a group of resources, or a previously created resource package.

To select a resource or group of resources:

a. In the Live Search View, browse Live resources (for example, search for the Log Collector

resource Type).

b. In the Matching Resources panel, select Show Results > Grid.

c. Select the checkbox to the left of the resources that you want to deploy.

L. _— "
& NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports
LIVE CONTENT CAPTURE POLICIES NCIDENT RULES NCIDENT NOTIFICATIONS
Search Criteria Matching Resources
Keywords Show Results ¥ | | ¥ Package
]| Subscribed Name Created Updated
Catesory 0 ne Windows Events (NIC) Log ... 2015-11-22 2:15 PM 2018 26 PM
CJFEATURED M no AWS CloudTrail Log Collec... 2017-06-16 11:38 PM 2019-06-14 7:41 AM
b [ THREST O no Micrasoft Exchange Log Col..  2015-11-22 1:46 P 2018 7PM
» C10ENTITY ™ ne Symantec Critical System...  2015-11-22 6:38 AM 2018-07-07 2:20 PM
) D assURANCE [0 no 2015-11-22 6:32 AM 2018-08-26 12:04 PM
O nc 2015-11-22 6:16 AM
» [] OPERATIONS ne <
0 ne 121 DEZ Log C 2015-11-22
[CISPECTRUM §
[ ne MeAfee Web G; 2015-11-22 6
[ MALWARE ANALYSIS
O no Tenable Ne 2015-11-22
Resource Types O no SunOne LDAP 2015-11-22 6:
v 0 ne Oracle Access manager Log...  2016-04-07 5:03 AM 2019-04-12 12:02 PM
ger Log
Medium O no MS Azure Log Collector Con...  2018-08-21 1:56 PM 2019-06-12 1:08 PM
v O no MeAfee Integrity Control Lo...  2015-11-22 6:2 2018
O ne Actiance Vantage Log Colle...  2015-11-22 6:09 AM 2018-07
Danuiirad hMats Ko 1. _ _ I
S
170 Matching Resources

admin v

PARSER RULES

Type Description
Log Collector Log Collector configurat
Log Collector Log Collector configurs
Log Collector Log Collector canfigurat

Log Collector Log Collector configura

Log Collector configurar

configurat
configurat
configurat
configurat
configurat
configurat
configurat

ctor configurat

ctor configurat

T
Ly

d. In the Matching Resources toolbar, click «* PRI9Y

Deployment Wizard

Resources Services Review

Total resources: 2

Resource Names Resource Type Dependency of

Symantec Critical Systems Protection Log Celle...  Log Collector

AWS CloudTrail Log Collector Configuration Log Collector

Deploy

Cancel Next

19
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3. To select a resource package to deploy:
a. In the Live Search view - Matching Resources toolbar, select Package > Deploy .

The Package page of the Resource Package Deployment wizard is displayed.

Resource Package Deployment

Package Resources Services Review Deploy

Resource Bundle Browse

Cancel

b. Click Browse and select a package from your network (for example resourceBundle-
FeedsParsersContent.zip).

c. Click Open.

At this point, whether you are deploying a package or a group of resources, the Deployment
Wizard opens, and the Resources page is displayed.

4. Click Next.
The Services page displayed has two tabs, Services and Groups, which provide a list of services and

Q
service groups that are configured in the (Admin) > Services view. The columns are a subset of
the columns available in the Services view.

Note: The Live server is "smart" about deploying resources to Services. For example, it does not
deploy resources that have a Medium of packets to any Log Decoders. This means that only
applicable content resources are deployed to each Service.

5. Select the services on which you want to deploy the content. You can select any combination of
services and service groups.

* Use the Services tab to select individual services, list of services, and service groups that are
configured in the KZ4M (Admin) > Services view.

¢ Use the Groups tab to select groups of services.

Deploy Content 20
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Deployment Wizard

Resources Services Review Deploy
(| ﬁ MName ~ Type
[l # UlEndpoint Other

Cancel Previous Next
6. Click Next.
The Review page is displayed.
Deployment Wizard
Resources Services Deploy
Service Service Type Resource Name Resource Type
Ul Endpoint NW Local Basic Rule Template RSA Event Stream Analy...
Cancel Previous Deploy
Make sure that you have selected correct resources and the services on which you want to deploy
them.
7. Click Deploy.
The Deploy page is displayed. The Progress bar turns green when you have successfully deployed
the resources to the selected services.
21 Deploy Content
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Deployment Wizard

Resources Services Review

Live deployment task finished successfully

Service Name Resource Name Status Progress

Ul Endpoint Basic Rule Template 10f1 ‘ y

Close

If you try to deploy resources and services that are not compatible, NetWitness displays the Errors
and Retry buttons, which you can click to review the errors and re-attempt the deployment.

Package Resources Devices Review

Deployment in progress...
Device Name Resource Name Status Progress
Log Decoder4  Malware Domains 3of3 e ———

8. Click Close.
Next steps

After deploying parsers to Decoders and Log Decoders, you must enable parsers on the individual
services. For more information, see the Decoder and Log Decoder Configuration Guide.

Deploy Content 22
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Manage Live Resources

With a connection to the CMS server, you can search for, subscribe to, and deploy resources from Live
in accordance with your subscription level. Once you have found resources, you deploy them to services

A
and service groups that have been configured in the the (Admin) > Services view.

Create Live Set up Live Find/Deploy Manage Live
Account Services Live Resources Services

(Optional)
Configure Feedback
& Data Sharing

Search/Download
Live Content

There are several workflows for deploying resources to services and managing those deployments. These
include:

* Subscribe and deploy resources

* Deploy a resource bundle

* Remove deployments of resources
* Download resources

* Set up data feeds

Manage Subscription and Deployment

The subscription and deployment workflow takes advantage of the resource management tools available
in Live. By subscribing to resources, you agree to receive updated resources in accordance with the

4
synchronization configured in the (Admin) > System > Live Services panel.

By adding subscribed resources to the deployments list, you configure NetWitness to automatically push
those resources to the selected services at the configured synchronization intervals. This method requires
some planning of service groups and services where resources are deployed. In addition:

* You can remove a resource from the deployments list in the Deployments Tab.

* You can unsubscribe from a resource in the Subscriptions Tab and the Live Resource View.

23 Deploy Content
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To manage subscriptions and deployment:

Q
1. Inthe (Admin) > System > Live Services panel, specify an interval at which NetWitness
checks for updates to subscribed resources in Live and specify the email addresses of people to
receive an email listing subscribed resources that have been updated.

2. Inthe (Configure) > Live Content search view, search for and subscribe to Live resources.

3. Inthe (Configure) > Subscriptions > Deployments tab, select subscribed resources and add
them to the deployment list for services groups.

* to deploy the

=

4. (Optional) In the (Configure) > Subscriptions > Deployments tab, click *
resources listed in the Deployments tab immediately.

5. In the (Configure) > Subscriptions > Deployments tab, select deployed resources from a
Group, and remove them from services.

6. In the (Configure) > Subscriptions tab, unsubscribe from resources.

Remove a Deployed Resource

Once deployed to a service, Live resources remain on the service until removed. It is a good practice to
remove unused resources from services on which they are deployed.

To remove deployed resources:

1. Go to the Live Resource View

2. Unsubscribe from a resource, and remove it from deployed services.

Deploy a Resource Bundle

To deploy a content package, use the Resource Package Deployment Wizard. You can deploy a content
package created in Live to one or more services. NetWitness accepts packages in .nwp files or .zip files.

Download Resources

To download resources to your local file system, use the Download button in the Live Resource view.

Set Up Data Feeds

In the Live > Feeds view, you can set up and maintain Custom and Identify feeds.

Deploy Content 24
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Search and Download Content from NetWitness XDR Cloud Services Live

Administrators can search for live content using the Search Content panel in the NetWitness XDR Cloud

Services Live, which is similar to browsing the live CMS content in the (Configure) > Live Content
page on the NetWitness Platform.

Note: If Admin server is not connected to the Live Services, you can use the NetWitness XDR Cloud
Services Live to search and download the required content.

Create Live Set up Live Find/Deploy Manage Live
Account Services Live Resources Services

Search/Download ‘(Optlonal)
i Configure Feedback
Live Content

& Data Sharing

Prerequisites

e Ensure that you have created the Live account. For more information, see Create Live Account.

Quick Search for Content

You can now select and view the content based on the Sources available in the Cloud Services Live. You
can select either NetWitness or Community from the Source drop-down list.

o NetWitness: Displays all the content provided by NetWitness.

¢ Community: Displays the content collected and retrieved from third party and open source
communities.

Note: The Only Opensource option will appear under the Search Content panel only when the

community is selected as the source. You can use this option to select and search open-source
related content.

You can also quickly select and view the available content types under Content section.

Clicking ] expands the Content section and displays the following options:
o New: Displays the content which is created in the last 21 days.

* Recently Updated: Displays the content which is created or updated in the last 21 days.
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Advanced Search for Content

You can search for the specific content in the Search Content view. For more information, see Live

Search Content View.

To search the content:

1. Click B to expand the Search Content section.

2. In the Search Content, specify the search criteria. Enter any or all of these: keyword, type of
resource, medium, tag, platform versions, meta keys, meta values, date when content was created,
date when content was modified, and (optional) discontinued content.

SOURCE : Community

Only Opensource

Content

Search Content

KEYWORDS

RESOURCE TYPES

MEDIUMS

TAGS

new

PLATFORM VERSIONS

11.5.0.0

REQUIRED META KEYS

GENERATED META VALUES

CREATED DATE

2022-08-16

MODIFIED DATE

2022-09-06

» Include Discontinued

3. Click Search.

The matching results are displayed on the right panel.

Reset Filter

Deploy Content
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& Content

View Ne ecently updated and community content details here.

Showing Filtered Content (877) Timezone : GMT+0530 Asia/Calcutta
NAME 3 CREATED * UPDATED 4 TYPE 4 MIN PLATFORM VERSION 4 DESCRIPTION 4 DISCONTINUED *

11-Sep-202001:2... 17-Jul-2022 10:01... Feed Al Versions This feed contains IP Address (IPv4 and IPvé) indicators that a... No
26-Nov-2020 16:5... 26-Nov-2020 16:5... Not found 11.5.00 This dashboard provides information on various NetWitness P... No
26-Nov-2020 16:5... 26-Nov-2020 16:5... Not found 11500 This dashboard provides information on NetWitness Platform... No
11-Sep-202001:2... 17-Jul-2022 10:01... Feed Al Versions This feed contains Non-IP Address, text based indicators like ... No
26-Nov-2020 16:3... 26-Nov-2020 16:3... Not found 11.5.00 Amount of Incoming UDP Packets Requested by Endpoint ser... No
26-Nov-2020 16:4... 26-Nov-2020 16:4... Not found 11.5.0.0 Capture is not started on this Decoder service, so packet data... No
06-Aug-2020 20:5... 13-Aug-202 5 Application Rule 11.5.00 Ahash mismatch may indicate a file has been altered fromits o... No
23-Dec-2020 16:4... 23-Dec-2020 16:4... Log Device 11.5.0.0 Log device content for event source AWS Route53 Resolver -...

19-Mar-202119:3... 19-Mar-202119:3... Log Device 11500 Log device content for event source Cisco Umbrella - cisco_um...

26-Nov-2020 16:2... 26-Nov-2020 16:2... Not found 11.5.00 Reporting Engine home directory /var/netwitness/re-server/r...

26-Nov-2020 16:4... 26-Nov-2020 16:4... Not found 11.5.0.0 80% of the Contexthub Server's query response cache is in use.

26-Nov-2020 16:3... 26-Nov-2020 16:3... Not found 11.5.0.0 Decoder is presently not capturing data.

You can sort the content using the name, created, updated, type, or any of the column.

Note: Clicking Reset Filter removes the existing filters applied from the Search Content, and
displays all the available content on the right panel.

Download Content

You can download the content from the results displayed in the right panel by performing the following
steps:

Note:

- You cannot download a discontinued content.

- NetWitness provides no assurance related to the quality and accuracy of the content provided by the
third parties and open source communities.

To download the content:
1. Click name of the content that you want to download.

The Content Details dialog is displayed.

27 Deploy Content



Live Services Management Guide

Content Details

NOTE: The following content s collected and derived from third-party, open sources. RSA
° [NetWitness] at no times makes claims to the quality and/or efficacy above and beyond the
attestations of the authors of the content itself.

[Community] Malware, Malicious Code and APT Open Source YARA
Rules

UPDATED

DESCRIPTION

Mediums

None

@ Large files may take longer time to start the download.

2. Click Download.

The content file is downloaded.
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Additional Procedures

This topic explains the additional procedures an administrator could choose to follow which are not
essential for the configuration or use of Live Services.

e Export Data to RSA

e Packaging Resources

e Manage Custom Feeds

e Creating a Custom Feed

e Create a STIX Custom Feed

e Creating and Managing an Identity Feed

Editing a Feed

e Removing a Feed

e Miscellaneous Live Services Procedures
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Export Data to RSA

A NetWitness administrator can export the metrics in NetWitness for Live Feedback.

About Live Feedback

In the Live Services Configuration panel, there is a Live Feedback Activity Log which enables you to
download the usage data required for Live Feedback. This is active regardless of the Live
Account configuration.

If the Live Account is not configured, you can manually upload the usage data to RSA. For more
information, see the "Configure Live Services Panel" topic in the System Configuration Guide.

You must first download the Live Feedback historical data, and then upload it to share with RSA.

Download Live Feedback Historical Data

To download the Live Feedback historical data:

QA
1. Goto (Admin) > System.
2. In the options panel, select Live Services.

The Live Account screen is displayed which consists of the RSA Live Status and Download Live
Feedback Activity Log.

3. Click Live Feedback Activity Log.

The Live Feedback Activity Log window opens which allows you to download the required Live
Feedback historical data.

Live Feedback Activity Logs

Download menthly anonymized activity logs and manually upload to BSA secure portal,

For use only when live account is not configured.

Ll pate Range v Last Download Date

] 2017, June30-18

| Page |1 | of1 | | C PageSize 10 ~ Displaying 1-1 of 1

Close

4. Select one or multiple entries by selecting the checkboxes and click Download.

Note: If you select multiple entries in the history table, the Live Feedback data is downloaded into
a ZIP archive, consisting of individual JSON files for each month.

Share Telemetry Data to NetWitness

After you download the Live Feedback data, you can then upload it using the following procedure.
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Note:

- To download the Live Feedback data, see topic Download Live Feedback Historical Data.

- You can share data NetWitness XDR Cloud Services Live portal. For more information, Create Live
Account.

To share the data to RSA:

1. Log in to the NetWitness XDR Cloud Services using your Live account credentials.

2. Click on the left panel.
The Telemetry Logs dialog is displayed.

L Telemetry Logs

Upload Live Feedback Activity Logs

Click or drag-and-drop the .zip file to upload.

Note:
- You can upload only .zip files.
- Filename must be 255 characters or less and file size must be less than 128 MB.

3. Click or drag-and-drop a file onto this area to upload.
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Packaging Resources

The primary use for creating and subsequently deploying a resource package is for customers using an
air gap network environment. In this case, you create a resource package on the network that is
connected to the internet, and then deploy the resource package on a more secure network.

Create and Deploy Resource Package Use Case

The basic steps are as follows:
1. Access NetWitness Live Services using an instance that is connected to the internet.
2. Create a Resource package as described below, adding whichever content items you need.

3. Copy the ZIP archive of the packages to your secure NetWitness instance, by using a thumb drive or
other manual copying process.

4. On the secure NetWitness instance, deploy the resource package. For more information, see Resource
Package Deployment Wizard.

Prerequisites to Create a Resource Package

A prerequisite for creating resource packages is configuration of the connection and synchronization
between the CMS server and NetWitness and the ability to search for resources in the User Interface.

Creating a Resource Package

The following procedure describes how to create a resource package, as a ZIP archive and save it to your
local file system.

To create a resource package:

1. Goto (Configure) > Live Content from the NetWitness UL

2. Select the resources that you want to package in the Matching Resources grid.
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:\J’{f NETWITNESS

Respand

LIVE CONTENT SUBSCRIPTIONS

Search Criteria

» I THREAT

» CJIDENTITY
b [ ASSURANCE
» [ OPERATIONS
[ SPECTRUM
[ MALWARE ANALYSIS

Resource Types

Medium

Dmmniiead Matn Kae

CAPTURE POLICIES

Users Hosts Files

INCIDENT RULES

Matching Resources

Show Results @ |

| subscribed Name

O no Wind ents (NIC) Log ...
™ no AWS CloudTrail Log Collec...
O no Microsoft Exchange Log Col...
™ no Symantec Critical System...
O no Oracle Log Collector Config...
O no EMC Documentum

O ro 1BM DB2 Log Collector Conf..
O no McAfee Web

O no Tenable Netwo

O ro SunOne LDA

O no sz manager Log...
O no ure Log Collector Con...
O ro ee Integrity Control Lo,
O ro Actiance Vantage Log Calle...

170 Matching Resources

Dashboard

Reports

INCIDENT NOTIFICATIONS

Created
2015-11-22 215 PM
2017-06-16 11:38 PM
2015-11-22 1:46 PM
2015-11-22 6:38 AM
2015-11-22 6:32 AM
2015-11-22 &:1

2015-11-22 &:20 AM

2015-11-22 6:2

2015-11-22 6:3

2015-11-22

2016-04-07 5:03 AM

2018-09-21 1:56 PM

2015-11-22 6:26 AM

2015-11-22 &:09 AM

| 3% package ©
Updated
2018-07-07 2:26 PM
2019-06-14 7:41 AM
2012-07-07 2:17 PM

2018-07-07 2:20 PM

2018-08-26 12:04 PM

2012-
2018-
2018-
2012-
2018-
2019-
2019
2019
2018-07-07 2:11 PM

ESA RULES

CUSTOM FEEDS

Type
Log Callector
Log Collector
Log Cellector
Log Collector

Log Collect

admin v

LOG PARSER RULES

Description
Log Collector configurati
Log Collector configure
Log Collecor configurat
Log Collector configura

Log Collector configurati

configurat

cror

onfigurat
or configurat
cror configurats
or configurat
cror configurati
or configurat
cror configurati

cror configurat

3. Select some or all the resources that are listed in the Matches Resources pane.

4. Select % Package -

> Create.

NetWitness creates a .zip archive that contains the selected resources and downloads it to your default
download folder. NetWitness gives the package a generic name. You should rename it when you save it
so that it identifies the resources contained in the package.

Creating Threat Package

The following procedure describes how to create a resource package that contains all the content that is
categorized as Threat. Then we rename it, using the type of content and date.

1. Goto - (Configure) > Live Content.

2. From the Category section, select Threat.

3. Select all items returned by clicking on the checkbox in the column header row of the Matching

Resources pane.
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:'Jf‘l'f NETWITNESS

LIVE CONTENT

Search Criteria

» [ IDENTITY

F [ ASSURANCE
¥ [ OPERATIONS

Medium

Required Metz Keys

SUBSCRIPTIONS

spond

Users

CAPTURE POLICIE

Hosts Files

Matching Resources

HEERR R

E NE RE O

Aggressive Internal NetBIOS scan

Dashboard

INCIDENT RULES

Aggressive internal web portal sc...

Alert IDs By Profiled Source IP
Alerts By Profiled Source IP

All Risk Suspicious

All Risk Suspicious by Destinatio...

All Risk Suspicious by Session Size

All Risk Warning by Source IP
apt_artifacts

Archive From IP Address
Backdoor Activity Detected

Behaviors of Compromise

Repaorts

INCIDENT NOTIFICATIONS

Keywords 55 Show Results @ | 8] Deploy | 3 package ©
[ ¥} name ~ Type Description
™ Aggressive Internal Database Scan  Event Stream Analysis Rule  Detects a single host making connection attempts to 100 or more uniqu

Event Stream Analysis Rule
Event Stream Analysis Rule
NetWitness Rule
NetWitness Rule
NetWitness Report
NetWitness Rule

NetWitness Rule

[ SPECTRUM [¥ Al Risk Suspicious by Source IP NetWitness Rule Aggregates sessions by risk.suspicious and displays all results by ip.srci
o MALWARE ANALYSIS ¥ All Risk Warning NetWitness Report This report lists All Risk Warning by Source, Destination and Session Siz
¥ All Risk Warning by Destination [P NetWitness Rule Aggregates sessions by risk.warning and displays all results by ip.dst in

resource Types o All Risk Warning by Session Size  NetWitness Rule e e et tal e Twael e axtevinfmstellct s tute [ te il et

NetWitness Rule

Lua Parser

Application Rule

Event Stream Analysis Rule

NetWitness Rule

admin v

ESA RULES CUSTOM FEEDS LOG PARSER RULES

Detects a single host making connection attempts ta 100 or more uniqu
Detects a single host making connection attempts to 100 or more uniqu
Detects the meta key alert.id generated through basic correlation rules
Detects the meta key alert generated through application rules, which
This report lists All Risk Suspicious by Source, Destination and Session §
Aggregates sessions by risk.suspicious and displays all results by ip.dst

Aggregates sessions by risk.suspicious and displays all results by sessio

Aggregates sessions by risk.warning and displays all results by ip.src in
Detects possible apt WMI and windows registry manipulation. DEPENDE
archive directly from an ip address with no corresponding alias.host me
The rule will detect backdoor activity using logs. By default, the rule wil

Designated for suspect or nefarious behavior outside the standard sign -

3

> Create.

233 Matching Resources

4. Select * Package -

A ZIP archive is saved to your Downloads folder. For example,

resourceBundle8740753704980701969.zip.

5. Rename the package to something meaningful. For example, in this case, you cold change the
package name to threatResourceBundle 2018 01 31.zip (assuming today's date is January 31,

2018).

The resource package is now available for later deployment.

Deploying a Threat Package

This procedure assumes that you saved a package named threatResourceBundle 2018 01 31.zip, as
described in the previous section. It describes how to deploy a saved resource package

1. Goto . (Configure) > Live Content.

2. In the Matching Resources pane, select A Package

> Deploy.

3. Click Browse and navigate to the threatResourceBundle 2018 01 31.zip file that were created

earlier.
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Resource Package Deployment

Package Resources Services Review Deploy
Resource Bundle |threatResourceBundle_2018_01_31.zip Browse
Cancel Next
4. Click Next.
The Resources page displays details for the resources in the package.
5. Click Next.
The Services page displays two tabs, Services and Groups, which provide a list of services and
QA
service groups that are configured in the (Admin) > Services view. The columns are a subset of
the columns available in the Services view.
6. Select the services on which you want to deploy the content. You can select any combination of
services and service groups.
Deployment Wizard
Rescurces Services Review Deploy
Services m
[ # Name ~ Type
# UlEndpoint Other
Cancel Previous Next
7. Click Next.
The Review page is displayed.
Note: Make sure that you have selected correct resources and the services to which you want to
deploy them.
8. Click Deploy to complete the deployment process. Alternatively, you can choose Cancel or Previous
to either cancel the deployment or go back to the previous screen.
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Manage Custom Feeds

The custom feed capability is implemented using the Custom Feed Wizard in NetWitness, allowing you
to quickly populate Decoders with custom and identity feeds.

Custom Feed Creation

You can use the Live > Custom Feeds > Setup Feed > Configure a Custom Feed wizard to create and
deploy Decoder feeds based on deterministic logic that offers the meta keys specific to the selected
Decoders and Log Decoders. Although the wizard guides you through the process to create both on-
demand and recurring feeds, you should understand the form and content of a feed file when you create a
feed.

Feed file names in NetWitness are in the form <filename>. feed. To create a feed, NetWitness
requires a feed data file in .csv or .xm1 (for STIX) format and a feed definition file in . xm1 format,
which describes the structure of a feed data file. The Configure a Custom Feed wizard can create the
feed definition file based on a feed data file, or based on a feed data file and the corresponding feed
definition file.

The files that you use to create an on-demand feed must be stored on your local file system. The files
used to create a recurring feed must be stored at an accessible URL, whence NetWitness can fetch the
most current version of the file for each recurrence. After a NetWitness feed is created, you can
download the feed to your local file system, edit the feed files, and edit the NetWitness feed to use the
updated feed files.

Sample Feed Definition File

This is an example of a feed definition file named dynamic_dns.xml, which NetWitness creates based
on your entries in the Feed wizards. It defines the structure of the feed data file named dynamic_
dns.csv.

Note: The feed file path should be . csv regardless of the Feed Type (Default or STIX).

Sample Feed Definition File

<FDF xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:noNamespaceSchemaLocation="feed-definitions.xsd">
<FlatFileFeed name="Dynamic DNS Domain Feed"
path="dynamic_dns.csv"
separator=","
comment="4#"

version="1">

<MetaCallback
name="alias.host"
valuetype="Text"
apptype="0"
truncdomain="true"/>

<LanguageKeys>
<LanguageKey name="threat.source" valuetype="Text" />
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<LanguageKey name="threat.category" valuetype="Text" />
<LanguageKey name="threat.desc" valuetype="Text" />
</LanguageKeys>

<Fields>
<Field index="1" type="index" key="alias.host" />
<Field index="4" type="value" key="threat.desc" />
<Field index="2" type="value" key="threat.source" />
<Field index="3" type="value" key="threat.category" />
</Fields>

</FlatFileFeed>
</FDF>

Feed Definition Equivalents for Custom Feed Wizard Parameters

The NetWitness Feeds wizard provide options to define the structure of the data feed file. These
correspond directly to attributes in the feed definition (.xml) file.

NetWitness L . .
Feed Definition File Equivalent
Parameter
Define Feed tab
Feed Type Select: Default - to define a feed based on a .csv formatted feed data file.

STIX - to define a feed based on STIX formatted .xml file.

Feed Task Type Select: Adhoc - to create an on-demand feed. Recurring - to create a feed that
recurs automatically.

Name Enter a custom feed name in the feed data file that corresponds to the
flatfeedfile name attribute in the feed definition file; for example,
Dynamic DNS Test Feed,

File/ Browse Enter a name of the feed data file that corresponds to the flatfeedfile
path attribute in the feed definition file; for example, dynamic_dns.csv,

(STIX, Recurring) Select Trust All Certificate, if you do not want to validate the REST server
Trust All Certificate ccttificate. This option is enabled by default (checked).

(STIX, Recurring) For client authentication with the REST URL, in the Certificate field, click
Browse and select the self signed certificate. The supported certificate formats

Certificate/Browse " cer, .crt with Base64 & DER encoded files.

Define Feed tab - Advanced Options
XML Feed File Enter a name of the feed definition file, for example, dynamic_dns.xml,
Separator The separator character used to separate attributes in the feed data file. It

corresponds to the £latfeedfile separator in the feed definition file; for
example, a comma.
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NetWitness

Parameter

Feed Definition File Equivalent

Comment

Remove STIX data
older than

Select Services tab

(Define Columns tab,
Define Index) Type

(Define Columns tab,
Define Index) CIDR

(Define Columns tab,

Define Index)
Service Type

(Define Columns tab,
Define Index)
Truncate Domain

(Define Columns tab,
Define Index) Ignore
Case

(Define Columns tab,
Define Index)
Callback Keys

The character used to identify a comment in the feed data file. It corresponds
to the flatfeedfile comment attribute in the feed definition file; for
example, #.

The number of days for which the STIX packages downloaded from TAXII
server have to be stored. The STIX packages older than the specified number
of days are deleted automatically. The default value is 180 days, which is also
the maximum.

Select the services to which you want to send the data feed.

The type of lookup value in the index position of the feed data file.

IP means that each row in the feed data file contains an IP address in the
lookup value position. The IP value is in dotted-decimal format (for example,
10.5.187.42).

IP Range means that each row in the feed data file contains a range of IP
addresses in the lookup value position. The IP range is in CIDR format (for
example, 192.168.2.0/24). Non IP means that the each row in the feed data file
contains a metadata value other than IP address in the lookup value position.
The Service Type and Truncate Domain, and Callback Keys fields become
active for a Non IP index.

Specifies that the IP value in the lookup position is in CIDR format. The
CIDR attribute sets the IP address format in the field to Classless Inter-
Domain Routing (CIDR) notation.

For a Non IP index, the integer service type to filter meta lookups. It
corresponds to MetaCallback apptype attribute in the feed definition file. A
value of 0 indicates no filtering by service type.

For a Non IP index, for meta values that contain domain names (for example,
hostnames), the system can strip off the host specific element in the data.
Truncate Domain corresponds to the MetaCallback truncdomain attribute. If
the value is www.example.com, it is truncated to example.com. A value of
False selects no truncation, and True selects truncation.

If this option checked, the feed will ignore the case.

For a Non IP index, the available meta keys to match on instead of ip.src/ip.dst
(the defaults for IP index type) are selectable from the drop-down list.

The Callback Key corresponds to the MetaCallback name attribute, and

the index column of the csv file must contain data that can match the chosen
meta key. For example, if the username meta key is chosen, the index column
of the csv file needs to be populated with users to be matched.
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NetWitness

Feed Definition File Equivalent

Parameter

(Define Columns tab, Identifies the column in the feed data file that provides the lookup value for the

Define Index) row. Each position in each row of the feed data file is identified by a Field

Index Column index attribute in the feed definition file. A field with an index of 1 is the first
entry in a row, the second field has an index of 2, the third field has an index
of 3, and so on. You can select multiple index columns, if the Feed Type is
STIX and Index Type is Non IP, When you select multiple index columns the
values from all the selected columns are merged in the first index column that
you selected.

(DEFINE VALUES) The name of the LanguageKey, as defined in the feed definition file, for

Key which meta is created from this row of the feed data file. It corresponds to the
Field Kkey attribute in the feed definition file. A key applies only to a field
whose type is set to value, In the feed definition file, there is a list of
LanguageKeys from index.xml, or a summary name if Source Name and
Destination Name are used. For example, reputation is a summary name for
reputation.src and reputation.dst). This value is referenced by the Field key
attribute.
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Creating a Custom Feed

This topic provides instructions for creating a custom feed using a .csv or STIX formatted feed data file
in NetWitness. For more information about STIX and creating a STIX custom feed, see Create a STIX
Custom Feed.

You can easily create a custom feed using the Custom Feed wizard. To complete this procedure, you
need a feed data file in . csvor .xm1 format. If you also have an associated feed definition file

in .xml format, which describes the structure of the feed data file, you can use the feed definition file to
create a feed. The Custom Feed wizard can create the feed based on a feed data file, or based on a feed
data file and corresponding feed definition file.

After completing this procedure, you will have created a custom feed.

The feed data file (.csv or STIX (.xm1)) and optionally the feed definition file (. xm1) must be
available on the local file system for an on-demand custom feed. For a recurring custom feed, the files
must be available at a URL that is accessible to the NetWitness server.

Note: Any feeds that are created in 11.2 release or prior will be automatically pushed to Context Hub
as Lists. The lists can be looked up in the context lookup panel of the Respond and Investigate pages.
If Context Hub is not configured or the service is down, then the feeds will be pushed to Context Hub
the next time the server is available.

To create a custom feed:

1. Goto (Configure) > CUSTOM FEEDS.
The Custom Feeds view is displayed.

:‘:},‘ NETWITNESS  Investigate Respond Users Hosts Files Dashboard Reports admin w
LIVE CONTENT SUBSCRIPTIONS CAPTURE POLICIES INCIDENT RULES NCIDENT NOTIFICATIONS ESA RULES CUSTOM FEEDS
+ |

O Mame Trigger Disk Usage Created Last Run Time Status Progress

O TEST Once - 2019-07-1312:30:36  2019-07-13 13:30:36  Completed C——

O TEST2 Once - 2019-07-1313:50:33  2019-07-13 12:50:33  Completed C——

O e Once - 2019-07-14 04:16:51  2019-07-1404:16:51  Completed C——

O onlydom Ongce - 2019-07-14 04:21:37  2019-07-1404:21:37  Completad C—

O PCAP Once - 2019-07-14 0%:30:48  2019-07-14 09:30:49  Completed C——

2. In the toolbar, click +
The Setup Feed dialog is displayed.

Setup Feed

(® Custom Feed

) Identity Feed
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3. To select the feed type, click Custom Feed and Next.
The Configure a Custom Feed wizard is displayed, with the Define Feed form open.
(Configure a Custom Feed
Define Feed Select Services Define Columns Review
Feed Type ® sy O STIX
Feed Task Type @ Adhec Recurring
Name *
Hered !
File * Select File Browse
Advanced Options
Reset Cancel Next
4. To define a feed based on a . csv formatted feed data file, select CSV in the Feed Type field.
5. To define an on-demand feed task that executes once, select Adhoc in the Feed Task Type field and
do one of the following:
a. (Conditional) To define a feed based on a .csv formatted feed data file, type the feed Name.
b. Select the checkbox Upload As CSV File Feed, if required.
c. Select a .csv content File from the local file system, and click Next.
d. (Conditional) To define a feed based on an XML feed file, select Advanced Options.
The Advanced Options are displayed:
Configure a Custom Feed
Define Feed Select Services Define Columns Review
e. Select an XML feed file from the local file system, choose the Separator (default is comma), and
specify the Comment characters used in the feed data file (default is #), and click Next.
f. The Select Services form is displayed. This is an example of the form for a feed based on a feed
data file with no feed definition file. If you are defining a feed based on a feed definition file, the
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Define Columns tab is not needed.

Configure a Custom Feed

U o
L &
O
L &
O o
O
O o
L ##
O
08
O
Yy d
L &
0 &

Reset

Define Feed

Services Groups

O i Name ~

Select Services

Address

Define Columns

Type
Decoder
Decoder
Decoder

Log Decoder
Decoder

Log Decoder
Decoder
Decoder
Decoder
Log Decoder
Log Decoder
Decoder
Decoder

Log Decoder

Cancel

6. To define a recurring feed task that executes repeatedly at specified intervals, during a specified date

range.

a. Select Recurring in the Feed Task Type field.

The Define Feed dialog includes the fields for a recurring feed.

Configure a Custom Feed

Define Feed

Feed Type @ csv

Feed Task Type O Adhoc

Name * TestFeed

Upload As Csv
File Feed -

URL*
[ Authenticated

[ Use Proxy

Recur Every [

[ Date Range
) Advanced Options
XML Feed File | Select File
Separator

Comment #

Reset

Select Services

O sTX

@ Recurring

Define Columns Review

Verify

Browse

Cancel
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b. In the URL field, enter the URL where the feed data file is located, for example,
http://<hostname>/<feeddatafile>.csv, and click Verify.

NetWitness verifies the location where the file is stored, so that NetWitness can check for the
latest file automatically before each recurrence.

c. (Optional) If the URL has restricted access and requires authentication using your username and
password, select Authenticated.

NetWitness provides your user name and password for authentication to the URL.

d. If you want the NetWitness server to access the Feed URL through a proxy, select Use Proxy.
For more information on configuring a proxy, see the Configure Proxy for NetWitness topic in
the System Configuration Guide. By default, the Use Proxy checkbox is not selected.

NOTE:
If you are using an HTTPS based feed server, ensure that you import and install the certificates.
For more information, see Import Certificates for HTTPS Service

e. To define the interval for recurrence, do one of the following:
¢ Specify the number of minutes, hours, or days between recurrences of the feed.

¢ Specify recurrence every week, and select the days of the week.

f. To define the date range for the execution of the feed to recur, specify the Start Date and time
and the End Date and time.

Configure a Custom Feed

Define Feed Select Services Define Columns Review

Feed Type ® pefault STix

Feed Task Type O Adhoc ® Recurring

Name * TestFeed

URL* https://qasa2.netwitness local/live/feeds Verify
Authenticated

Use proxy

XML Feed File Browse
Separator

Comment

Reset Ccancel Next

7. (Conditional) If you want to define a feed based on an XML feed file:
o Type the feed Name, select Advanced Options.
The Advanced Options fields are displayed.

o Select an XML feed file from the local file system, choose the Separator (default is comma),
specify the Comment characters used in the feed data file (default is #) and click Next.
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The Select Services dialog is displayed.

Configure a Custom Feed

Define Feed

O] # | Mamme
="
Og
Op
Op
=)
=]
=)
=
=
=
=
O
=
O«

Select Services

Define Columns

Type
Decoder
Decoder
Decoder
Log Decoder
Decoder
Log Decoder
Decoder
Decoder
Decoder
Log Decoder
Log Decoder
Decoder
Decoder

Log Decoder

Review

8. To identify services on which to deploy the feed, do one of the following:

a. Select one or more Decoders and Log Decoders, and click Next.

b. Click the Groups tab and select a group. Click Next.

The Define Columns dialog is displayed.

9. To map columns in the Define Columns form:

a. Define the Index type: IP, IP Range, or Non IP, and select the index column.

b. (Conditional) If the index type is IP or IP Range and the IP address is in CIDR notation, select

CIDR.

c. (Conditional) If the index type is Non IP, additional settings are displayed. Select the service
type and Callback Keys, and optionally select the Truncate Domain and Ignore Case option.
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Configure a Custom Feed

Define Feed Select Services

Type Qe _ IP Range

Index Column 1 v Service Type 0

CallbackKey (S) |
0s

Detine Values access.point

Column accesses

Key action
SRM_Sag alert
ANcesr| alertid
| alias.host
 alias.ip
< alias.ipvé
alias.mac
asn.dst

asn.src

PR Ry

Define Columns Review

® Non IP

~

o [¥ Truncate Domain Ignore Case

]

fPE

Reset

Cancel Prev Next

d. Select the language key to apply to the data in each column from the drop-down list. The meta

displayed in the drop-down list is based on the meta available for the service define values. You
can also add other meta based on advanced expertise.

Configure a Custom Feed

Define Feed Select Services Define Columns Review
Define Inde
Type ow O IP Range ® Non IP
Index Column 1 v ServiceType 0 O [¥ Truncate Domain Ignore Case
Callback Key (S) action @ v
Define Values
Column 2 3 4
Key threat.source v threat.category v threat.desc
SRM_SaaS_ES MXASSETInterface AddChange EN
ANCESTOR ASSETNUM ASSETTAG ASSETTYPE
cent45 9164
cent45 9164
Reset Cancel Prev Next
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Note: When a custom feed gets converted into a context hub list, you must map at least one
meta key with one or more meta types by mapping a column header with a meta. However, you
can add or edit the entity mapping of a list by clicking ¥ in the Lists tab. For more
information, see the Context Hub Configuration Guide.

e. Click Next.
The Review dialog is displayed.

Configure a Custom Feed

Define Feed Select Services Define Columns Review

Testing

AssetsimportCompleteSample.csv
Log Decoder, Decoder

Other
action
true

0

1 2 3 4

Index threatsource threat.category threat.desc

Reset Cancel Prev Finish

10. Anytime before you click Finish, you can:
¢ Click Cancel to close the wizard without saving your feed definition.
¢ Click Reset to clear the data in the wizard.
¢ Click Next to display the next form (if not viewing the last form).
¢ Click Prev to display the previous form (if not viewing the first form)
11. Review the feed information, and if correct, click Finish.

12. Upon successful creation of the feed definition file, the Create Feed wizard closes, and the feed and
corresponding token file are listed in the Feed grid and progress bar tracks completion. You can
expand or collapse the entry to see how many services are included, and which services were
successful.

Note: When you create a feed, and if there is no entity mapping done such as in case of custom meta,
then those columns in the List will not have entity mappings in Context Hub. You have to manually
map the entities from the List page.

Import Certificates for HTTPS Service

Import certificates to communicate with the HTTPS services:
1. SSH to the NW node and copy the CA certificate located in the following directory:
/etc/pki/ca-trust/source/

2. Execute the following command to update the certificates:
update-ca-trust
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3. Execute the following command to add the certificate to the java keystore:
keytool -list -keystore /etc/pki/java/cacerts -storepass changeit |& head

4. Restart the service on the NW node.

Note: Perform the procedure for all the HTTPS servers.
Example: HTTPS proxy server and HTTPS feed server.

47 Deploy Content



Live Services Management Guide

Create a STIX Custom Feed

You can create a custom feed using a .csv or STIX formatted feed data file in NetWitness.

Note: NetWitness supports Structured Threat Information Expression (STIX) 1.0, 1.1 and 1.2 versions
only.

Structured Threat Information Expression (STIX™) is a structured language for describing cyber threat
information so it can be shared, stored, and analyzed in a consistent manner. For more information about
STIX, see https://oasis-open.github.io/cti-documentation/.

Caution: If STIX recurring feed is configured and you update Security Analytics from 10.6.x to
NetWitness 11.0, you must re-configure the STIX recurring feed.

In NetWitness Platform, STIX feeds are supported. STIX content (with version 11.x) can be uploaded in
an ".xml" format. The constructs such as Indicator Title and Description, Observable Title and
Description, and Indicator Sightings information are parsed from STIX and pushed to the decoders or log
decoders that are selected during feed configuration. Information such as IP addresses, File hashes,
Domain names, URIs, and Email addresses are extracted from the STIX observable to be included in the
feed.

Make sure the following criteria are met before you upload the STIX file:
1. Only STIX Observables with property values in the "Equals" operator
2. The uploaded STIX xml file must have only one STIX Package

TAXII (Trusted Automated eXchange of Indicator Information) is the main transport mechanism for
cyber threat information represented in STIX. Using the TAXII services, organizations can share cyber
threat information in a secure and automated manner.

The STIX and TAXII communities work closely together to ensure that they continue to provide a full
stack for sharing threat intelligence.

Apart from TAXII server, STIX data can also reside on REST server and you can fetch STIX file from
the REST server by providing the URL of the REST server. For example,
http://stixrestserver.internal.com.

The feed data file (. csv or STIX (. xm1)) and optionally the feed definition file (. xm1) must be
available on the local file system for an on-demand custom feed. For a recurring custom feed, the files
must be available at a URL that is accessible to the NetWitness server.

In NetWitness Platform, STIX (.xml) feed of type Indicators or Observable which contains the properties
such as the IP addresses, File hashes, Domain names, URIs and Email addresses are supported. The
properties values in the Equals operator is only supported. The STIX constructs that are parsed are
Indicator Title and Description, Observable Title and description and Indicator Sightings information.
The STIX (.xml ) with a single STIX Package is only supported.”

To create a STIX custom feed:

1. Goto (Configure) > CUSTOM FEEDS.
The Custom Feeds view is displayed.

Deploy Content 48


https://oasis-open.github.io/cti-documentation/
http://stixrestserver.internal.com/

Live Services Management Guide

l.~ - _

.—-’{: NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports admin v
SUBSCRIPTIONS CAPTURE POLICIES NCIDENT RULES INCIDENT NOTIFICATIONS ESA RULES CUSTOM FEEDS

+ \

O Mame Trigger Disk Usage Created Last Run Time Status Progress

O TEST Onee Completed e

O TEST2 Onee Completed e

O te Onee Completed e

O onlydom Onee Completed e

O PCAP Onee Completed e

2. In the toolbar, click +
The Setup Feed dialog is displayed.
Setup Feed

® Custom Feed

_) Identity Feed

3. To select the feed type, click Custom Feed and Next.
The Configure a Custom Feed wizard is displayed, with the Define Feed dialog open.

Configure a Custom Feed

Define Feed Select Services Define Columns Review

Recur Every 5 ¢ Minute(s) v
[] Date Range
Advanced Options
XML Feed File  Select File Browse

Separator -~

Comment #

Reset Cancel Next

4. Enter the following details:

a. Feed Type: Select STIX, to define a feed based on a STIX formatted . xm1 file.

=3

Name: type the feed name, to define a feed based on STIX formatted . xm1 file.
¢. STIX Source:Select a STIX data source from the drop-down which is added in Context Hub.

d. Recur Every: Specify a recurring feed task that executes repeatedly at specified intervals.

Note: NetWitness verifies the connection to the server, so that NetWitness can check for the latest
file automatically before each recurrence.

e. Date Range: Select the checkbox and specify the date range for the feed task to recur.
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5. (Optional) Select Advanced Options,to define a feed based on an XML feed file.
a. XML Feed file: Browse and select an XML feed file from the local file system.
b. Separator: Choose a separator (default is comma).
c. Comment: Specify the comment characters used in the feed data file (default is #).

6. Click Next.

7. The Select Services dialog is displayed. This is an example of the form for a feed based on a feed
data file with no feed definition file. If you are defining a feed based on a feed definition file, the
Define Columns tab is not needed.

[Configure a Custom Feed

Define Feed Select Services Define Columns Review

Services Groups

¥ & Nam Addi Type

Y 4 Log Decoder
~ & Decoder

8. To identify services on which to deploy the feed, do one of the following:

a. Select one or more Decoders and Log Decoders, and click Next.

b. In case of STIX feed, Context Hub will be selected by default and you are not allowed to deselect
it. In addition, you can select one or more Decoders and Log Decoders and click Next or Click
the Groups tab and select a group. Click Next.

If the data from the STIX server is large, the following message is displayed:

Fetching sample data is taking longer than expected.
Choose one of the following options

Continue to Wait Map without Sample data

e If you click Continue to Wait, it continues to wait till the sample data is fetched or timeout
(10 minutes) whichever is sooner. In case of timeout no sample data is retrieved even after 10
minutes.

¢ If you click Map Without Sample data, the mapping column is displayed without any sample
data.

The Define Columns dialog is displayed.

9. To map columns in the Define Columns form:
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a. Define the Index type: IP, IP Range, or Non IP, and select the index column.

b. (Optional) If the index type is IP or IP Range and the IP address is in CIDR notation, select

CIDR.

c. (Optional) If the index type is Non IP, additional settings are displayed. Select the service type

and Callback Keys, and optionally select the Truncate Domain option.

Configure a Custom Feed

Column
Key

Header

Reset

Define Feed
Type ®p
Index Column(S) 10

1

Indicator Title

Some Indicator
Some Indicator
indicator-domain

Another Indicator

Select Services

Indicator Description

<p>Some Indicator</p>
<p>Some Indicator</p>
auto domain test

<p>Another Indicator...

Define Columns Review
B 4
v

Observable Title Observable Description
domain:domaint.exa.. ~ domain:domaini.exa...
domain:domain2.exa... ~ domain:domain2.exa...
domain test domain desc
domain:domain3.exa...  domain:domain3.exa...

Cancel

Prev

Next

Note:

columns.

- If the Index Type is Non IP, you can select multiple index columns in the Index Column(S).
The values from all the selected columns are merged in the first index column that you selected
and the merged values are pushed to the Log Decoder for parsing. For example, in the Index
Column(S) if you select 2,4,7 as index columns the values from the 2,4 and 7 columns are
merged in the column 2 and the values are pushed to Log Decoder for parsing.

- Indexing cannot be done for the columns such as Indicator Title, Indicator Description,
Observable Title, Observable Description, as the look up cannot be performed for those

d. Select the language key to apply to the data in each column from the drop-down list. The meta
displayed in the drop-down list is based on the meta available for the service define values. You
can also add other meta based on advanced expertise.

e. Click Next.

The Review dialog is displayed.
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10.

11.
12.

L
X

Configure a Custom Feed

Define Feed Select Services Define Columns Review

FILESTIX
FILESTIX-stix.xml

PH - Decoder, LH - Log Decoder

IP
false
Index event.desc
Reset Cancel Prev Finish

Anytime before you click Finish, you can:

¢ Click Cancel to close the wizard without saving your feed definition.

¢ Click Reset to clear the data in the wizard.

¢ Click Next to display the next dialog (if not viewing the last form).

e Click Prev to display the previous dialog (if not viewing the first form)
Review the feed information, and if correct, click Finish.

Upon successful creation of the feed definition file, the Create Feed wizard closes, and the feed and
corresponding token file are listed in the Feed grid and progress bar tracks completion. You can
expand or collapse the entry to see how many services are included, and which services were
successful.

NETWITNESS n ate Xespond Users osts Files [BEH rd Reports admin

LIVE CONTENT SUBSCRIP CAPTURE PC s NCIDENT RULES INCIDENT NOTIFIC

Feeds

+
Name Trigger Feed Size Created Last Run Time Status Progress
FILEHASH Fetches STIX feeds from 2020-May-19 03:18, running every 5 minutes 0 bytes 2020-05-19 03,2523 2020-05-22 051601 Completed s
B FILESTIX Fetches STIX feeds from 2020-May-19 03:32, running every 5 minutes 0 bytes 2020-05-19 03:32:09 2020-05-22 05:12:09 Completed CEE—
B AllindicatorsREST Fetches STIX feeds from 2020-May-19 04:48, running every 5 minutes 0 bytes 2020-05-19 05:03:52 2020-05-22 05:13:26 Completed CE——
B AlLindEdited Fetches STIX feeds from 2020-May-19 05:13, running every 5 minutes 0 bytes 2020-05-19 0511354 2020-05-22 051354 Completed e
B TAXIlIServerl Fetches STIX feeds from 2020-May-19 05:44, running every 5 minutes 288 hytes 2020-05-19 05:44:38 2020-05-22 05:14,38 Completed eam———

Note: Health and Wellness raises alerts when the available heap memory of Context Hub server is
critically low and the status displays as unhealthy due to low memory. For more information on how to
troubleshoot the OutofMemoryError on the Context Hub Server, see "Troubleshooting" in the Live
Services Management Guide.
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MetaCallback Feeds using CIDR Index Range for IPv4 and IPv6

You can use CIDR index ranges for IPv4 and IPv6 in custom MetaCallback feeds. As with other custom
feeds, you must create feed data file in .csv format, and a feed definition file in .xml format.

Note: Using MetaCallback feeds with CIDR index ranges is supported only through the Advanced
Configuration wizard or the REST interface.

The following example shows the content of both a .csv file and an .xml file for a MetaCallback feed
using CIDR index ranges for [IPv4 or IPvo6.

CSV File Content

192.168.0.0/24, Sydney
192.168.1.0/24, Melbourne

XML File Content

<?xml version="1.0" encoding="UTF-8"?><FDF
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:noNamespaceSchemalLocation="feed-definitions.xsd">

<FlatFileFeed name="ip_ test" path="ip_test.csv" separator="," comment="#">
<MetaCallback name="DstIP" valuetype="IPv4" apptype="0" truncdomain="false">
<Meta name="ip.dst"/>

</MetaCallback>

<LanguageKeys>

<LanguageKey name="alert" valuetype="Text" />

</LanguageKeys>

<Fields>

<Field index="1" type="index" range="cidr"/>

<Field index="2" type="value" key="alert" />

</Fields>

</FlatFileFeed>

</FDF>

Note: To configure a CIDR index range for feeds with single or multiple MetaCallbacks of value type
[Pv4 or IPv6, the field of type index MUST contain a range attribute with range="cidr". Also,
configuring "cidr" index ranges for feeds with MetaCallbacks of multiple different value types is not
supported.
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Creating and Managing an Identity Feed

You can easily create an Identity feed and populate it to selected Decoders and Log Decoders. After
completing this procedure, you will have created an Identity feed.

To create an identity feed:

1. Add a destination for the feed.
4
a. Goto (Admin) > Services and in the Services.

b. In the list of services, select a Log Collector service, and select ﬁ ~ View > Config.

Select the Event Destinations tab.

d. In the Select Event Destinations field, select Identity Feed.

-+ Change Service . : Config

General Remote Collectors Files AU (-3 Event Destinations Settings

SEIE:.: EMENE ‘ Identity Feed w
Destinations

| Log Decoder
|dentity Feed  |identity Feed

+
e. Click and enter a unique name for the feed.
The Queue name identifies the feed within the Log Collector. Use the name of the feed for the
Queue.
Add Identity Feed
Name * infonetd_domain
Queue |infonetd_domain| |
Rollover Interval 3
Update Interval 1

Event Source Filter

Start Processor On 4
Service Startup

Cancel OK

f. Click OK.

2. Test generation of messages.

a. Have users log into Windows boxes on the domain to generate the appropriate log messages on
the domain controllers for testing.
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b. Verify that data is written to the feed files. SSH to the Log Decoder/Collector or Virtual Log
Collector being configured. Navigate to
/var/netwitness/logcollector/runtime/identity-feed and verify that the
Identity deploy files are getting populated with data.

[root@tps-reports identity-feed]# pwd
/var/netwitness/logcollector/runtime/identity-feed
[root@tps-reports identity-feed]# 1s -lah

total 20K

drwxr-xr-x. root root 109 Nov & 18:06 .

2
drwxr-xr-x. 8 root root 4 0K Nov 12 23:14
1

=MWN=F==r==, root root 106 Nov 13 15:24 identity.deploy.csv

. 1 root root| 408 Npv 13 15:24 identity_deploy.feed
-Mw=-r--r--, 1 root root _S9al Nov B 09:00 identity_deploy.xml
-rw-r--r--. 1 root root | 158 llov 13 15:17 identitycache.csv
[root@tps-reports identity-feed]# |

c. Open up a web browser (Non-Internet Explorer browsers preferred) and log in to the REST
interface of the Log Collector. Use administrative credentials when logging in. For example, if
the IP address of your Log Collector is 192.168.99.66, the URL would be:

* SSL not enabled: http://192.168.99.66:50101/event-processors
e SSL enabled: https://192.168.99.66:50101/event-processors

The browser screen should look like this:

800D Response 3
[al> | (2] + O 192.168.99.66:5010 ¢ | Q)
[I] & RSAT™ Wikiand eRoom ¥ RSALink ™ SA Y Personal ¥ J"—:

™)

)

The screen contains the name of the identity feed you created earlier (infonetd domain, in this
example).

For the identity feed to function correctly, port 50101 must be active on the Log Collector, and
you must determine whether SSL encryption is active.
2 -
d. Goto (Admin) > Services > <Log Collector being setup> {5 > View > Explore.

e. In the left pane, expand rest > config.
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& Change service | endpointloghybrid - Log Collector | Explore &
~— P ) . frest/config endpointloghybrid - Log Collector
Z endpointloghybrid - L... =
allow.missing.user.agent true
H k8l endpointloghybrid - Log Collector (LOG_C... .
allow.websockets false
B[ Jconnections ;
enabled 1
B[ deviczappliance port s0101
B[] event-broker - off

B[] event-processors useragentwhiteliss

B[] logcollection

B[ Jlogs

B rest
[Jeenfig
[ stats

B[] sdk

For REST to be active, enabled must be set to 1.

f. Note the value for ssl. If SSL should be enabled for your environment, this must be set to on.

Note: If you changed the setting for either the enabled or ssl option you must restart the Log
Collector service before moving forward.

3. Goto (Configure) > Custom Feeds.
The Feeds dialog is displayed.

a

5 NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports admin
LIVE CONTENT SUBSCRIPTIONS CAPTURE POLICIES INCIDENT RULES NCIDENT NOTIFICATIONS SA RULES CUSTOM FEEDS
+ |

O Mame Trigger Disk Usage Created Last Run Time Status Progress

O TEST Crice Completad e

O TEST2 Crice Completad e

O = Crice Completad e

O Crice Completad e

O Crice Completad e

4. In the toolbar, click +
The Setup Feed dialog is displayed.

Setup Feed

Custom Feed

(@) Identity Feed

Cancel

5. Make sure Identity Feed is sclected and click Next.
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The Configure Identity Feed panel opens with the Define Feed tab displayed.

6. (Conditional) You can create an on-demand or recurring feed.

¢ To define an on-demand Identity feed task that executes once, select Adhoc in the Feed Task

Type field, type the feed Name, and browse for and open the feed.

o To define a recurring Identity Feed task that executes on a recurring basis, select Recurring in the

Feed Task Type field.

The Define Feed dialog includes the fields for a recurring feed.

Configure Identity Feed

Select Services Review

Define Feed

Feed Task Type Adhoc @® Recurring

Name *

[ Authenticated  User Name admin Password esessssses

[ Use proxy
Recur Every 5 & Minute(s)

Date Range

Start Date 2015-12-1419:10:25 (i End Date  2025-12-1413:11:27

Reset Cancel

URL * >r name]?msg=getfile&force-content-type=application/octet-stream&expiry=600 || Verify

Note: NetWitness verifies the location where the file is stored, so that NetWitness can check for
the latest file automatically before each recurrence.

7. Enter a value and verify the URL field.

a. In the URL field, enter the URL where the feed data file is located. This is the REST API
interface that was setup earlier. Make sure you have the following information to construct the

URL:

e The IP address of the Log Collector being used to construct the Identity Feed file.

¢ The identity queue name, as set in step 2c.

e Whether or not SSL is enabled on the Log Collector REST port, as set in step 2f.

You can construct this value as follows:

e SSL enabled: https://<LogCollector>:50101/event-processors/<ID Event
processor name>?mnsg=getFile&force-content-type=application/octet-

stream&expiry=600

e SSL not enabled: http://<LogCollector>:50101/event-processors/<ID Event
processor name>?mnsg=getFile&force-content-type=application/octet-

stream&expiry=600

So, using the example from earlier, the complete value that you would enter into this field is as

follows:

http://192.168.99.66:50101/event-processors/infonetd
domain?msg=getFile&force-content-type=application/octet-

stream&expiry=600?msg=getFile&force-content-type=application/octet-

stream&expiry=600
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b. For the URL verification to work correctly, it is important that the NetWitness Ul server can
access the Log Collector’s REST API port (50101). This can be tested by going to the
NetWitness Ul server via SSH. Once there, run the following command:

e SSL enabled: curl -vk https://<ip of log collector>:50101

¢ SSL not enabled: curl -v http://<ip of log collector>:50101

If the curl command does not connect then there may be a network firewall or routing issue
between the NetWitness Ul server and the Log Collector.

Example of a bad connection:

* About to connect() to 192.168.99.66 port 50105 (#0)
* Trying 192.168.99.66... No route to host

* couldn't connect to host

* Closing connection #0

curl: (7) couldn't connect to host

Example of a good connection:

About to connect () to 192.168.99.66 port 50105 (#0)

Trying 192.168.99.66... connected

Connected to 192.168.99.66 (192.168.99.66) port 50105 (#0)

GET / HTTP/1.1

User-Agent: curl/7.19.7 (x86 64-redhat-linux-gnu) libcurl/7.19.7
SS/3.19.1 Basic ECC zlib/1.2.3 1libidn/1.18 libssh2/1.4.2

Host: 192.168.99.66:50105

Accept: */*

HTTP/1.1 401 Unauthorized

Content-Length: 71

Connection: Keep-Alive

Pragma: no-cache

Expires: -1

Cache-Control: no-cache, no-store, must-revalidate
WWW-Authenticate: Basic realm="NetWitness"

*
*
*
>
>
N
>
>
>
<
<
<
<
<
<
<
< Content-Type: text/xml; charset=utf-8

<

<?xml version="1.0" encoding="utf-8"?>

<error>401 Unauthorized</error>

* Connection #0 to host 192.168.99.66 left intact
* Closing connection #0

8. The REST API requires a username and password when attempting to pull the identity
deploy.csv file from the Log Collector. This can be any username and password that is available
on the service itself. For more information, see the "Services Security View" topic in the Hosts and
Services Guide.

Q
To see which accounts are available, go to (Admin) > Services > <log collector being setup>
> Actions > View > Security.

Under the Users table, you see all the users that can be used in this step. It is suggested that a
separate user account is created specifically for this setup, and is used nowhere else in the
environment, for added security. For details, see "Add a User and Assign a Role" in the System
Security and User Management Guide. (Go to the NetWitness All Versions Documents page and find
NetWitness Platform guides to troubleshoot issues.)

9. To define the recurrence interval, do one of the following:
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10.

11.

12.

13.

14.

¢ Specify the number of minutes, hours, or days between recurrences of the feed.
¢ Enter the date range for the execution of the feed to recur, specify the Start Date and time and the
End Date and time.

If using SSL encryption, you need to install the REST API SSL certificate for the Log Collector into
the NetWitness Ul server. For more information, see Import the SSL Certificate.

If, after importing the SSL certificate, the verification of the URL still fails, see Cannot Verify
Identity Feed URL.

Click Verify to verify your identity feed configuration before you proceed to the Select Services
dialog.

Click Next.

The Select Services dialog is displayed.

Configure Identity Feed

Define Feed Celect Services Review
L ﬁ( Name ~ Address Type
O & ' Decoder Decoder
] 55( Log Decoder Log Decoder
Reset Cancel Prev Mext

To identify services on which to deploy the feed, select one or more Decoders and Log Decoders
and click Next.

Click the Groups tab, select a group, and click Next.
The Review dialog is displayed.
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Configure Identity Feed

Define Feed Select Services
eed Details
Mame Testing
Feed File zip sample.zip
Service Details
Sery Decoder

Cancel

Note: If a group of devices with Decoders and Log Decoders is used to create recurring or custom
feeds and this group is deleted, you can edit the feed and add a new group to the feed.

15. Anytime before you click Finish, you can:
¢ Click Cancel to close the wizard without saving your feed definition.
¢ Click Reset to clear the data in the wizard.
¢ Click Next to display the next form (if not viewing the last form).
¢ Click Prev to display the previous form (if not viewing the first form).
16. Review the feed information, and if correct, click Finish.

Upon successful creation of the feed definition file, the Create Feed wizard closes, and the feed and
corresponding token file are listed in the Feed grid and progress bar tracks completion. You can expand
or collapse the entry to see how many services are included, and which services were successful.

L s
.r§; NETWITNESS n e Respond Users Hosts Files

admin w

LIVE CONTENT SUBSCRIPTIONS CAPTURE PO ES INCIDENT RULES INCIDENT NOTIFIC

Feeds

+

0 Name Trigger Feed Size Created Last Run Time Status Progress
B FILEHASH Fetches STIX feeds from 2020-May-19 03:16, running every 5 minutes 0 bytes 2020-05-19 03:25:23 2020-05-22 05:16:01 Completed CEE—
B FILESTIX Fetches STIX feeds from 2020-May-19 03:32, running every 5 minutes 0 bytes 2020-05-15 03:32:08 2020-05-22 05:12:08 Completed e
B AllindicatorsREST Fetches STIX feeds from 2020-May-19 04:48, running every 5 minutes 0 bytes 2020-05-19 05:03:52 2020-05-22 05:13:26 Completed e
B AlLindEdited Fetches STIX feeds fram 2020-May-19 05:13, running every 5 minutes 0 bytes 2020-05-19 0511354 2020-05-22 0511354 Completed C——
B TAXIIServert Fetches STIX feeds from 2020-May-19 05:44, running every 5 minutes 288 bytes 2020-05-19 05:44:38 2020-05-22 05:14:38 Completed aEmmm———
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Import the SSL Certificate

If SSL is configured on the Identity feed’s Log Collector, follow these steps to import the Log
Collector’s SSL certificate into the NetWitness Ul server key store. If this certificate is not imported, the
NetWitness Ul server will be unable to pull the Identify feed file from the Log Collector.

1. To pull the SSL certificate off the Log Collector, SSH into the NetWitness Ul server and run the
following command:

echo -n | openssl s client -connect <HOST>:<PORT> | sed -ne '/-BEGIN
CERTIFICATE-/, /-END CERTIFICATE-/p' > /tmp/<SERVERNAME>.cert

This command saves the SSL certificate to /tmp/<SERVERNAME>. cert. For example:

echo -n | openssl s client -connect 192.168.99.66:50101 | sed -ne '/-BEGIN
CERTIFICATE-/, /-END CERTIFICATE-/p' > /tmp/logcollector.cert

2. To import the SSL certificate into the NetWitness Ul server, SSH into the UI server and run the
following command:

keytool -importcert -alias <name an alias for the cert> -file <the cert
file pathname> -keystore /etc/pki/java/cacerts

For example:

keytool -importcert -alias logcollector0l -file /tmp/logcollector.cert -
keystore /etc/pki/java/cacerts

3. The system requests a password. Enter the password for the keystore on the NetWitness Ul server,
not for the jetty keystore. The default password is changeit.

4. Restart jettysrv to allow jetty to read the new certificate in the store.
Cannot Verify Identity Feed URL

If the Identity feed URL cannot be verified, and you are using SSL, make sure you followed the steps in
Import the SSL Certificate.

If there are issues, it is possible that the internal name of the certificate does not match the hostname of
the Log Collector. The following procedure checks this.

1. SSH to the NetWitness Ul server.

2. Run the following command to output the CN name of the SSL cert:

echo -n | openssl s client -connect <log decoder>:50101 | sed -ne '/BEGIN
CERTIFICATE-/, /-END CERTIFICATE—/p'

For example:

echo -n | openssl s client -connect salogdecoder01:50101 | sed -ne '/BEGIN
CERTIFICATE-/, /-END CERTIFICATE-/p'

3. Retrieve the CN name of the SSL certificate.
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4. Edit the /etc/hosts file and add the IP address and CN name to the file.

5. Restart the network service on the appliance.

6. Confirm that the name placed in the /etc/hosts file is used instead of the FQDN or IP address in the
Identity feed URL.

7. Re-verify the Identity feed URL.
Investigating an Identity Feed
An identity feed tracks interactive log on events from the Windows operating system. Identity feeds do

not track interactive log off events.

In order for an identity feed to process events and tag them, the events need to be collected using
a Windows Log Collection module where an Active Domain Controller or non-Domain Controller is
configured. Note that identity feeds can only be processed via an Identity Feed Event Processor.

Note: An identity feed only tracks one log in at a time. If two users log in to a system at the same
time, the second user will overwrite the first user's data in the identity feed.

Once you have created an identity feed, you can view the results by investigating the feed.

To investigate a configured identity feed:
1. Go to INVESTIGATE > Navigate.

If no default service is selected, the Investigate dialog is displayed.

Investigate

Services Collections

M Default Service

Name ~ Address Type

Eroker 10.31.125.243 Eroker
Broker 10.31.125.245 Broker
Broker 10.31.125.240 Broker
Cancentrater (Default) 10.31.125.244 Cancentratcr
Decoder 10.31.125.245 Decoder

Log Decoder 10.31.125.246 Log Decoder

Cancel Mavigate
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2. Select a service, usually a Concentrator, and click Navigate.

3. Select Load Values to retrieve meta data.

In the Values panel, scroll down to find the Meta Keys:

Respond Users Hosts Files Dashboard

¥ NETWITNESS

NAVIGATE EVENTS WARE ANA

& endpointloghybrid - Concentrator ¥ Query ® [ Profile &

2012 35 | 15:35:00 (+00:00)

[ Meta &

All Data

Reports

| "= Total ®

/= Descending @ &§ Event Count & |

2017

Save Events &

07
19

admin w

[
14:50:59 (+00:00) g
el
pat
—
o
Q
=~
c
o
£ Options | Hide

) R

.. Decoder Source (2 v

ot
nwappliance23912 (=100.0 5%) - nwappliance11639 (182)
3 o
@ - Alerts (13
test dom (>100. 59%) - gw match (=100

8

test (3,095) - ipv4 potential web sweep 10 (2,280,
- ipv4 bulk data transfer S0 mb (17)

Risk: Informational (20 of 20+ values) 2

-
http1.1 without referer header (67.513) - unknown service over http port (51.581) - unknown service over smtp port (43,798) - http1.1 without server header (39,937) - http1.0
unsupported cache header (34,360) - http1.0 unsupported connection header (32.546) - http1.0 unsupported host header (21,538) - http1.1 server location redirect (21,090) - only

ack flag in session (18,655) - unknown service over ssl port (15,679) - http1.0 without server header (12,163) - http over non-standard port (11.872) - http1.1 without accept
_httn1 0 unsinnarted etas header (68971 - httn1

- 38%) - ipv4 horizontal port scan 5 (6,458) - tele test (5,773) - address : 161.253.11.233 (4,948) - ip alert for 29.1 (3,581) - sky
0) - ipv4 vertical tcp port scan 5 (2,204) - ipv4 vertical udp port scan 5(210) - ipvd bulk data transfer 20 mb (76) - ipsrc test 176 (37)

1 withnut cannactinn

header 11 129 _httn1 1 hich headar ranunt (10 @A _ httn1 Dwithaut refarar headar (7 SNAY

The identity feed provides information to selected Decoders and Log Decoders. It associates the Host IP
data from the Windows operating system to the user logging into that Host in order to tag all logs

associated with that IP and investigate.
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Editing a Feed

This topic provides instructions for editing a custom feed using the Custom Feed Wizard.

After you edit a feed:

* The feed (.zip format) or the file used to create the feed (.csv or .xml) has been downloaded and
edited.

e The feed has been recreated with the updated file and new feed specifications.

To edit an existing feed:

1. Goto (Configure) > CUSTOM FEEDS.
The Custom Feeds dialog is displayed.

nd Users Hosts Files Dashboard Reports admin
OMTENT SUBSCRIPTIONS CAPTURE POLICIES INCIDENT RULES NCIDENT NOTIFICATIONS SA RULES CUSTOM FEEDS
+ |
O Mame Trigger Disk Usage Created Last Run Time Status Progress
O TEST Crice Completad e
O TEST2 Crice Completad e
O = Crice Completad e
O onlydom Crice Completad e
O PCAP Crice Completad e

4

2. In the toolbar, select a feed and click =,

The Configure Custom Feed or Configure Identity Feed panel opens in the Custom Feed wizard.

Configure a Custom Feed

Define Feed Select Services Define Columns

Feed Type C5v = STIX
Feed Task Type @ Adhoc _} Regurring
W ame * TEST

Upload &s Csw

File Feed
File * TEST-2tix. xrm Browse
download file
\dvanced Options
Reset Cancel Mext
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3. If you want to edit the feed file:
a. Click download file.

For an Identity feed, the .zip file is downloaded. For a custom feed, the .csv or .xml file is
downloaded to your local file system.

b. Edit and save the file.
c. In the Define Feed tab, browse for and open the edited file.

4. Edit any other parameters in the Define Feed tab, Select Services tab, and Define Columns tab that
apply to the type of feed.

5. Anytime before you click Finish, you can:

¢ Click Cancel to close the wizard without saving your changes.

¢ Click Reset to clear the data in the wizard.

¢ Click Next to display the next form (if not viewing the last form).

e Click Prev to display the previous dialog (if not viewing the first form).
6. In the Review tab, review the feed information, and if correct, click Finish.

The feed is added to the feeds list and progress bar tracks completion. Upon successful creation of the
feed definition file, the Create Feed wizard closes, and the feed and corresponding token file is listed in
the Feeds list. You can expand or collapse the entry to see how many services are included, and which
services are successful.
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Removing a Feed

This topic provides instructions for removing a feed. You might want to remove a feed when some or all
of the information in the feed is no longer useful for your organization.

To remove a feed:

1. Goto (Configure) > CUSTOM FEEDS.
The Custom Feeds dialog is displayed.

.,’lr,‘ NETWITNESS 1 ate Respond Users Hosts Files Dashboard Reports admin v
LIVE CONTENT SUBSCRIPTIONS CAPTURE POLICIES INCIDENT RULES NCIDENT NOTIFICATIONS ESA RULES CUSTOM FEEDS
+ |

O Mame Trigger Disk Usage Created Last Run Time Status Progress

O TEST Once - 2019-07-1313:30:36  2019-07-13 13:30:36  Completed C——

O TEST2 Once - 2018-07-1313:50:33  2019-07-13 13:50:33  Completed C——

O e Once - 2018-07-14 04:16:51  2019-07-14 04:16:51  Completed C——

O onlydom Ongce - 2019-07-14 04:21:37  2019-07-1404:21:37  Completad C—

O PCAP Once - 2019-07-14 09:30:49  2019-07-14 09:30:49  Completed C——

2. In the toolbar, select a feed and click ~— .

The Delete Custom Feeds dialog is displayed.

Delete Custom Feeds

Local DB and Service

® Local DB Only

Service Only

Cancel Delete

You can select one of the following options to delete the feed:

¢ If you choose to delete the feed from Local DB and Service, the feed is deleted from both
the service and the local NetWitness box. The deleted feed will no longer seen on
the NetWitness user interface.

¢ If you choose to delete the feed from Local DB Only, the feed is deleted from the local
NetWitness box. The deleted feed will not be seen on the NetWitness user interface; however, the
last deployed version of the feeds will be present on the service. The undeployed feeds will be
deleted forever.

o If you choose to delete the feed from Service Only, the feed is deleted from the service. The
deleted feed will appear on the NetWitness user interface and can be deployed again
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3. Select which feed you want to delete and click Delete.
A warning dialog is displayed.

4. Click yes to confirm that you want to delete the feed from the selected areas.

Delete Custom Feeds

Service Status Progress

Decoder FAILURE
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Subscribing to Live Resources

This section describes subscriptions in Live.

Threats and the corporate landscape change over time. NetWitness periodically reviews existing content
to determine whether it needs to be updated based upon current campaigns, or has become irrelevant due
to changes in technology or attack techniques and tools.

You can discover new content by using the What’s New dashlet within the Default Dashboard, or by
searching through RSA Live by data range since last deployed. Be sure to subscribe to any content for
which you want to receive update notifications.

Subscription Updates

When you view resources in the Matching Resources panel of the Live Content view, there is a column
named Updated:

Matching Resources

= Show Results | | % Package
Subscribed | Wame Created Updated Type Description
na Advanced Windows Execut..  2012-02-09 4:50 PM 2014-03-20 353 FM FlexParser Legacy: Intenc
no Fingerprint Windows M5l 2012-02-09 4:51 FM 2012-02-09 4:51 FM FlexParser Legacy: Intenc
no Microsoft Windows 2018-03-27 148 FM 2018-03-27 147 FM Log Device Log device cor
yes windows_executable 2013-10-18 1:53 FM 2017-11-13 235 FM Lua Farser dentifies winc
no Windows Cormnmand Shell 2012-02-09 4:51 FM 2013-08-27 7:08 AM FlexParser Legacy: Intenc
yes Lateral Movernent Indicato...  2018-03-09 12:34 AM 2018-07-31 7539 FM Met\Witness Report Report display
yes windows_command_shell_|..  2013-10-181 20161114 6:40 PM Lua Parser dentifies Micr
yes Windows Credential Harves...  2016-03 2016-03-09 12:54 AM NerwWitness Rule This rule moni
o Windows Process Parent C... 2018-05-1 2018-05-11 734 FM MetWitness Rule There are sets
yes Windows NTLM Newwork La...  2016-03-09 12:54 AM 2016-03-09 12:54 AM NerWitness Rule ndicates a po
no Autoruns and Scheduled Ta...  2018-05-11 733 FPM 2018-05-11 7:33 FM NerwWitness Rule Attackers will
no Windows Events (ER) 2014-02-14 354 AM 2018-03-27 830 AM Log Device Log device cor
na Windows Events (NIC) 2014-02-14 3:55 AM 2018-09-0312:11 PM Log Device Log device cor _

E 4
66 Matching Resources

This value is also displayed when you select the detailed view for a resource. Every time a resource
changes, its Updated value changes to match the specific update. If you are subscribed to a resource, and
it gets updated, your system is automatically updated with the latest version, and you receive a

e

notification. You can view your notifications by clicking the Notification icon,
the NetWitness UL

, from anywhere in
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LIVE CONTENT SUBSCRIPTIONS

CAPTURE POLICIES

-
,’:;' NETWITNESS Investigate Respond Users Hosts Files Dashboard

INCIDENT RULES

INCIDENT NOTIFICATIONS

Notifications

N . Service Added
viatchin Test - Log Collecror service has been added to Test 1 hour
== Show Resulis 3 kage
Keywords B Show Resulis @ | | % Package Entitlement Expiration
Subscribed | Name Created Updated D 11 hours
Category o 2017-11-21 715 PM
[Treaturen o 201805
» CITHREAT yes 201512~
45 DENTITY no Wuitiple Login Failures Due... 2016 View All
Authentication no Multiple Failed Logins to 5 2016 £V
Authorization no WM Clone After Muitiple Ro. 201812, Eu 104 or higher_ Alert if there
Accounting 0 2016 Ewt Detects 4 failed login attemp
b [ ASSURANCE no Remaote Data Harvesting 2016 Ew Detects a successful Juniper
ASSURAN
b [ OPERATIONS yes ountlogon-failure 20714-08-1 Application Rule NWFL App Rule to support I
OPERA s
[ sPECTRUM yes ountlogin-and-lo... 2014-08-1 Application Rule NWFL App Rule to support I
SPE M
[T MALWARE ANALYSIS yes ountlogon-success 2014-08-1 Application Rule NWFL App Rule to support I
MALWARE ANALYSIS
yes ountlogout 2014-08-1 Application Rule NWFL App Rule to support It
Resource Types . R I _ ~
no Malicious Account Crestion...  2014-02 201612 3 Event Stream Anal...
no NTLMSSP_lua 2013-09-16 3:086 AM 2015-05-30 5:06 &AM Lua Parser Extra ctive Dire €
3
64 Matching Resources

You can also get email notifications when subscribed resources are updated. System Administrators can

a
add email addresses in the (Admin) > SYSTEM > Live Services view. For more information, see
the "Live Services Configuration Panel" topic in the System Configuration Guide.

Adding Subscribed Resources for Deployment to Services

—

Go to (Configure) > Subscriptions > Deployments.

2. In the Groups panel, select a group.
Subscribed resources, if any, are listed in the Deployments tab Subscriptions panel.

3. In the Subscriptions panel, click +

The Add Subscription dialog, which lists subscriptions available for deployment, is displayed.
4. Select the subscribed resources that you want to deploy to the services group.

Click Save.

The dialog closes and the subscriptions are added to the listing in the Deployments tab, Subscriptions
panel. This stages the resources for deployment at the next synchronization.

6. You can click the Synchronize icon, ** , to immediately synchronize your changes.

5

Deleting a Subscription

When you delete a subscription to a resource, deployed instances of the resource are not deleted. The
deployed resource remains on services until explicitly removed, but the resource is no longer
synchronized with the resource in NetWitness Live.
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To delete a subscription:

. Goto (Configure) > Subscriptions.

In the Subscriptions tab, select the subscriptions you want to delete.

Click =, then choose Delete to delete your selected resources or Delete All delete all subscriptions.
A dialog asks for confirmation that you want to delete the subscription.
To confirm removal, click Yes.

Your selected subscriptions are deleted from the subscriptions list, but any deployed instances of the
subscribed resource remain on the services.

Removing Subscribed Resources from the Deployments Subscriptions Grid

Subscriptions that are selected for deployment to a service group are deployed during synchronization.

You can remove subscriptions from the Live (Configure) > Subscriptions > Deployments panel, but
any that have actually been deployed to services remain deployed until someone removes them.

To remove resources from the Deployments tab Subscriptions panel:

1.
2.

Go to (Configure) > Subscriptions > Deployments

In the Groups panel, select a group.

Subscribed resources, if any, are listed in the Subscriptions panel.
In the Subscriptions panel, click =.

A dialog requests confirmation that you want to delete the resource from the service group. The
resource is removed from the Deployments tab Subscriptions panel, but is not removed from services
on which it is deployed.

Subscribe and Unsubscribe to a Resource

When you subscribe to resources, you will receive notification when new versions of the resources are
available.

To subscribe to a resource:

—_

. Goto (Configure) > Live Content.

In the Search Criteria panel, specify search criteria and click Search.

Select one or more resources and click ™ Subscribe |

A confirmation dialog is displayed: By subscribing to these resources, you are indicating that you
wish to receive notification when new versions are available.

To confirm that you want to subscribe to the resource, click OK.

The resource is added to the subscriptions managed in the Subscriptions tab and is available for
deployment in the Deployments tab.
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When unsubscribing from a resource, you have the option to leave the resource on services on which it is
deployed or to remove it from services.

To unsubscribe from a resource:

1. Open a detailed view of a resource in one of the following ways:

Perform a search, - (Configure) > Live Content > enter search criteria, then select the
resource in the Matching Resources panel, then click =/ Details

View subscriptions, (Configure) > Subscriptions, select the resource from the Subscriptions
list, then click =/ Details

., _ .
.Z:’.’ NETWITNESS Inv gate Users Hosts Files Dashboard

Reports admin w

LIVE CONTENT SUBSCRIPTIOMNS CAPTURE POLICIES INCIDENT RULES INCIDENT NOTIFICATIONS

F, Dowrload 3 Unsubscribe .3, Deploy

(1]

AWS Critical VM Modified Report

MNetWitness Report
2015-06-16 11:45 PM
2015-06-16 11:45 PM

10.5 and higher. Detects when Amazon Web Services (AWS) critical
virtual machine instances are modified. Actions detected by this
module include instances being terminated, stopped and rebooted as
well as modification of instance attributes and monitoring status. In
order to trigger an alert, a custom feed of critical instance source IPs
must be created to populate the alert meta key with the value
"critical_vm". Dependent on the CEF log parser.

0.1

2. With the detailed view of a resource displayed. click % Unsubscribe .

A confirmation dialog is displayed.
Unsubscribe Resource?

You will no longer be notified of new updates to this
resource.

Resource will stll be installed unless you manually remove it

Cancel Unsubscribe Unsubscribe and Remove

3. Do one of the following:

¢ To confirm that you want to unsubscribe from the resource and leave it on the services where it is
deployed, click Unsubscribe.
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¢ To confirm that you want to unsubscribe from the resource and remove it from the services where
it is deployed, click Unsubscribe and Remove from Services.

¢ To close the dialog without unsubscribing, click Cancel.

The selected action is applied.

Viewing Subscribed Resources Selected to Deploy on Services

In the (Configure) > Subscriptions > Deployments tab you can view subscribed resources that
have been selected for deployment on services.

To view subscribed resources that have been selected for deployment on services:

In the Groups panel, select a group, and expand it to view services in the group. The resource
subscriptions selected for deployment are listed in the Deployments tab Subscriptions panel.
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Miscellaneous Live Services Procedures

This section describes several other procedures.

Displaying Resource Details in Live Resource View

After you select a resource (in the Live Resource View), you can view its detailed information.

To open a separate tab in the Live Resource view with details of a selected resource, do one of the

following:

o If you are viewing the Detailed Results, click the resource type icon or the resource name.

-
.l'!:i' NETWITNESS Inve:

LIVE CONTENT SUBSCRIPTIONS CAPTURE POLICIES INCIDENT RULES
Search Criteria Matching Resources
Keywords Show Results |
malware
By Malware Domains
Coregory x Feed 2017-07-19 1:02 AM
[JFEATURED List of domains 2 v
» LI THREAT @ threat, malware
» CJIDENTITY oo
= Malware Domain List

» ] ASSURANCE

» [ OPERATIONS

Resource Types

Medium

Required Meta Keys

Generated Meta Values

shboard Reports

Feed 2017-07-17 1Z2:40 AM

List of domains

@ threat, malware

Malware IP List
Feed 2017-07-17 12:45 AM 0.
List of ip add sociated with malw

javascript or launch actions

m 57 Matching Resources

INCIDENT NO

ated with malwari
yry. threat.desc,

ory. threat.dese,

arser 2012-02-09 4:51 PM

Legacy: Intended only for 9.8. For SA deployments v

0.869

e sourced from

1567 32.55KB yes

TIFICATIONS ESA RULES CUSTOM FEEDS

| 3 Package ~

yes
aredomains.com.

malwaredomains.com

450 G no
alwaredomainlist.com

varedomainlist-domain

alwared

vare sourced from v

threat.source [ malwaredomainlist-ip

0.1 17.51 KB no

ersion 10 and above, see lua parser fingerprint_pdf_|ua Detects PDF files that contain

nainlist.com.

admin

LOG PARSER RULES
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 If you are viewing the list results, double-click a resource or select a resource and click Details.

LY ; ,
S NETWITNESS e 2 d ] Files Da: admin
LIVE CONTENT  SUBSCRIPTIONS CAPTURE POLICIES INCIDENT RULES INCIDENT NOTIFICATIONS SA RULES CUSTOM FEEDS LOG PARSER RULES
Search Criteria Matching Resources
Keywords Show Results @ | Details & Deploy ™ Subscribe | 3§ Package ©
malware [ subscribed| Name Created Updated Type Description
Catego ™ yes Malware Domains 2012-02-09 4:48 PM 2017-07-21 1:02 AM Feed List of domains associ
[ FEATURED yes Malware IP List 2012 4:48 PM 7 Feed List of ip addresses cor
» CJTHREAT no Domain List 20 8 PM Feed List of domains commo
» CJ1DENTITY yes PDF 2012 FlexParser Legacy: Intended only f

2017 s Report raffic that has

» [ ASSURANCE

» [ GPERATIONS s Rule DNS packet tre

= Rule ket snd log
Resource Types

10 000000000000

Netl < Rule Displays web-based pac
~
na Application Rule The SchoolBell rule dew
Medium e FlexParser Legacy: Intended only f
~ no RSAFi Command ... Feed This feed contains IPs tf
no RSA Fir: rch Cammand ... Feed This feed contains Dom
Required Meta Keys
na Dreambot Malware Application Rule The Dreambot is a bank
no Mirage M Application Rule Detects malicious outhe
Generated Meta Values ~

57 Matching Resources

Downloading a Resource

You can download a single resource from the Live Resource View.

To download a resource:

1. Goto (Configure) > Live Content.

2. In the Search Criteria panel, enter the criteria needed to return the resource you want to download.
3. Select a single resource, then click =/ Details

¥
4. Click s Download

The resource is saved as a ZIP archive to your local Downloads folder.

Locating and Removing a Deployed Resource from Services

You can locate and remove a deployed resource from services from the Live Resource View.

To view a list of services on which a resource is deployed:

1. With a resource displayed in the Resource View, click EE. Service Locator

The Service Locator dialog is displayed.
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Service Locator

= Remo

5

Services
[ # Name ~ Type

O nwappliance19848 - Log Decoder Log Decoder

Cancel

2. Select one or more services in the Services list.
3. Click =.

The resource is removed from the selected services.

Showing Results as a List or in Detail

1. Select Show Results > Grid to change to grid results when viewing detailed results.

'.’5.’ NETWITNESS gate c d 5 Hosts Files board d admin
LIVE CONTENT  SU RIPTIONS CAPTURE POLICIES INCIDENT RULES INCIDENT NOTIFICATIONS ESA RULES CUSTOM FEEDS
Search Criteria Matching Resources
Keywords Show Results = | Details ., Deploy 3 Subscribe | 3§ Package
malware [ subscribed Name Created Updated Type Description
Category M yes Malware Domains 2017-07-21 1:02 AM Feed List of domains associ
[JFEATURED [T yes L% are IP List 2017-07-207:21 PM Feed List of ip addr w
» CTHREAT O ne Malveare Demain List Feed List of domains commo
¥ CIIDENTITY [ yes Wzlware PDF FlexParser Legacy: Intended only fi
» [ ASSURANCE O no NetWitness Report  Displays traffic that has
» ] OPERATIONS O no NerWitness Rule Displays DMS packet trz
O ro NetWitness Rule Displays packet and log
Resource Types
. O ne Ne Rule Display based pac
O ne SchoclBell Ma Application Rule The SchoolBell rule dete
Medium [0 ne Flame Malware Detection FlexParser Legacy: Intended only fi
h O ro RSA FirstWatch Command . Feed This feed contains IPs o
Required Meta Keys O ro RSA FirstWatch Command . Feed This feed contains Dom
O ro Dreambot Malware Application Rule The Dreambot is a bank
O ne Mirage Application Rule Detects malicious outbc
Generated Meta Values A R L . _ -
57 Matching Resources
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2. Select Show Results > Detailed to change to detailed results when viewing grid results.

INETWITNE ny E espand

Users Hosts Files Dashhoard Reports admin v

LIVE CONTENT su CRIP CAPTURE POLICIES INCIDENT RULES INCIDENT NOTIFIC ONS U s C oM DS O« ER RULES

Search Criteria
Keywards

malware

Category

[ FEATURED

¥ [ THREAT

» [ IDENTITY

» [ ASSURANCE

¥ [ OPERATIONS

Resource Types

Medium
Required Meta Keys
Generated Meta Values i

Matching Resources
[

Show Results

Y Malware Domains
3 Feed 017-07-19 1:02 AM -

List of domail h malware sourced from s

@ threat, m e £ threat.category, threat.des, thr domains.com
Y Malware Domain List
x Feed 201707

List of domains commonly

@ threat, malware £ threat.ca

2:40 AM 0.1490 85.91 KB no

iated with malware sourced malwaredomainlist.com

alwaredomainlist-domain

sgory, threat.desc, threat.sourc

Ry Malware IP List

a Feed 2017-07-17 12:45 AM 0.1567 32.55KB yes

List of ip addresses common ciated with malware sourced from www.malwaredomainlist.com.

e £ threat.

@ threat, malw egory, threat.desc, threat.source g malwaredomainlist-ip

gy Malware PDF
ﬁ’ FlexParser 2012-02-09 4:51 PM 0.1 17.51 KB no
: Intended cnly for 9.8. For SA deployments version 10 and above, see lua parser fingerprint_pdf_lua Detects PDF files that contain
ipt er launch actions

57 Matching Resources

Viewing Resource Details

You can display detailed information about a subscribed resource in the Resource View.

To view details:

1. In the Subscriptions tab, select a single subscription.

2. Click [ Details
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The details of the resource are displayed in the Resource View.

NETWITNE N\ o Respond Hosts Files Dashboard Reports admin W

LIVE CONTENT SUB CAPTURE POLICIES INCIDENT RULES INCIDENT NOTIFICATIONS 54 5 C A FEEDS

. Download R Subscribe B Deploy €D Service Locator

) Malware Domain List

Feed
2012-02-09 4:48 PM
2017-07-20 12:40 AM

List of domains commonly associated with malware sourced from
www.malwaredomainlist.com

0.1491

79.256 KB

@ threat, malware
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References

This topic is a collection of references, which describe the user interface and more detailed information
about how Live works in NetWitness. These topics are presented in alphabetical order.

Deploy Content 78



Live Services Management Guide

Live Configure View

In the Live Configure view, NetWitness provides integrated tools for managing Live resources. You can
manage resource subscriptions, deployments to services and discontinued resources. The required role to
access this view is Configure Live Resources. For a high-level description of how to use the different
views in NetWitness Live, please read Live Services Management.

To access this view, navigate to (Configure) > Subscriptions. The view has three tabs:
Deployments Tab, Subscriptions Tab, and Discontinued Resources Tab.
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Deployments Tab

The Deployments tab provides a user interface in the Live Configure view for:
e Viewing subscribed resources that are selected for deployment on services in a service group.
» Selecting subscribed resources to deploy to services in a service group.

* Removing resources that are selected for deployment on services in a service group.
The resources listed here are not deployed immediately after adding to a service group. Instead the

subscribed resources are pushed to the services when NetWitness synchronizes with NetWitness Live.
The synchronization schedule is configured in the Live Configuration panel. Additionally, you can

synchronize immediately in the (Configure) > Subscriptions > Deployments tab.

Likewise, resources deleted from the Deployments panel are not deleted from service where they have
been deployed. To delete resources from services, delete them in the Live Resource View.

The required permission to access this view is Manage Live Resources.
To access this view:

1. Goto (Configure) > Subscriptions.
The Subscriptions tab is displayed.
2. Click the Deployments tab.

LN N o - -
.‘1}'. NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports admin v

LIVE CONTENT SUBSCRIPTIONS CAPTURE POLICIES NMCIDENT RULES INCIDENT NOTIFICATIONS ES s FEEDS

Subscriptions  EPEVIMTNERIGE Discontinued Resources

Groups Subscriptions
Mame Address Type | g

0| name Created Updated Discontinued Type Description

The Deployments tab has two panels: Groups and Subscriptions.
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Groups Panel

The Groups panel is a static display of configured service groups that were created in the Administration
Services view. Selecting a group in the Groups panel populates the Subscriptions panel with a list of
subscriptions that are selected for deployment on the services in the service group.

o Lown

Name Displays the service group name. Clicking the plus sign displays a nested list of services in the group.
Address Displays the IP address of each service in the group.
Type Displays the type of service.

Subscriptions Panel

The following table describes the features in the Subscriptions panel.

P omerpion

+ Click + to open a dialog that lists subscriptions that were added in the Live Search view or in the
Live Resource view and are available for deployment.

Click ~ to delete the selected subscriptions from the deployment list for service group.

o Click ** to synchronize your resources to the latest versions available on Live.
Name Displays name of the resource.
Created Displays date and time that the resource was created.
Updated Displays date and time that the resource was last updated.
Type Displays type of resource.

Description Displays description of the resource.

81 Deploy Content



Live Services Management Guide

Subscriptions Tab

Subscriptions are NetWitness Live resources to which you subscribed in the Live Search view or Live
Resource view. When you subscribe to a resource, you agree to receive updates on a regular basis from
RSA NetWitness Live. The choices made in the Live Configuration panel determine the synchronization
frequency and also whether you receive update notifications through email. In addition, if you don't want
to wait for the next update, you can force an immediate synchronization.

The Subscriptions tab provides a way to manage subscriptions. Each resource to which NetWitness is
subscribed is listed in this tab.

In the Subscriptions tab, you can:
e View all resources to which this NetWitness instance is subscribed.
e Open a detailed view of a subscription in the Live Resource View.

¢ Delete a subscription.

Note: Subscribing to a resource does not deploy the resource to any services. To deploy one or more
subscribed resources, go to the Deployments tab. To deploy a single resource manually, use the
Deploy option in the Resource View.

The required permission to access this view is Manage Live Resources.

To access this view, in the main menu, selec (Configure) > Subscriptions. The Subscriptions tab
is displayed.

L 7 =
S NETWITNESS  Investi : osts  Files

LIVE CONTENT SUEBSCRIPTIONS CAPTURE POLICIES MCIDENT RULES MCIDENT NOTIFICA

LG IVIGLEE Deployments  Discontinued Resources

- | :@:
[ Mame Type Version Discontinued Updated Description
yp P p
O CIMalware IP List Decoder Feed 0.1567 no 2017-07-17 12:45 AM List of ip addresses commaonly associated ...
[0 [CJMalware Domains Decoder Feed 0.869 no 2017-07-19 1:02 AM List of domains associates with malware so...

The Subscriptions tab has a toolbar and a grid.
Toolbar

This table describes the options available in the toolbar.

Description

Deletes the selected subscriptions.

Details  Displays the details of a single subscribed resource in the Resource View.
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Grid

Check the Live Server for the latest discontinued resources.

™

Name
Type
Version

Discontinued

Selects subscribed resources to view in detail or delete. You can view details for a single
resource. You can delete one or more resources from the subscribed resources, in effect
unsubscribing.

Displays name of the subscribed resource.
Displays type of subscribed resource.
Displays version of the subscribed resource.

Indicates the status of the discontinued resources for the subscribed resource.
Yes - Resource is discontinued.

No - Resource is not discontinued.

--- The Live Server is not checked for the discontinued resources.

Updated Displays date and time when the subscribed resource was last updated.
Description Displays description of the subscribed resource.
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Discontinued Resources Tab

The Discontinued Resources tab provides a user interface in the Live Configure view:

e Scan the services for the discontinued resources.

o Remove the discontinued resources from any service or service group.

Note: Discontinued content still appears. With discontinued content there just won’t be any updates,
and users won’t see these items when they search in Live, unless they check the Include Discontinued
Resources box while searching.

In the RSA Content space on NetWitness Community, you can view the complete, up-to-date list of
discontinued resources (Discontinued Content). For each resource, there is a description of why it was
discontinued. Use these details to determine whether or not to remove a discontinued resource from your
installation. .

The required permission to access this view is Manage Live Resources.

To access this view:

1. Goto (Configure) > Subscriptions.
The Subscriptions tab is displayed.
2. Click the Discontinued Resources tab.

The Discontinued Resources tab is displayed.

:Jg.' NETWITNESS Inve: = nd Users Hosts Files Dashboard Reports

LIVE CONTENT SUBSCRIPTIONS CAPTURE POLICIES INCIDENT RULES INCIDENT NOTIFICATIONS

Subscriptions  Deployments GGG

Groups Discontinued Resources on Service
BT -
Mame Address Type O Name Type Version Discontinued Updated Description
4 Al
Bl Decoder 10.31.125... Decoder

The Discontinued tab has two panels: Groups and Discontinued Resources on Service.

Groups Panel

The Groups panel is a static display of configured service groups that were created in the Admin
Services view. Selecting a group in the Groups panel populates the Discontinued Resources panel with a
list of discontinued resources which are deployed on the selected service or service group.
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s

Name

Address

Type

Click the button to scan the services for a discontinued resource.

Displays the current status of the discontinued resources on a service.

Note: The status of a service may change while the services are being scanned.

Displays service group name. Clicking the plus sign displays a nested list of services in the group.
Displays IP address of each service in the group.

Displays type of service.

Discontinued Resources on Service Panel

The following table describes the features in the Discontinued Resources on Service panel.

N N

Name
Type
Version

Discontinued

Click the button to delete the selected resources from the service or service group.

This is the name of the resource.
This is the type of resource.
Version of the discontinued resource.

Indicates the status of the discontinued resources for the subscribed resource.
Yes - The resource is discontinued.
No - The resource is not discontinued.

-- - The Live Server is not checked for the discontinued resources.

Updated Displays date and time that the resource was last updated.
Description Displays description of the resource.
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Live Feeds View

Use the Live Feeds View to:
e Create custom feeds.

e Create identity feeds.

e Edit feeds.

The required role to access this view is Manage Devices.

To access this view, navigate to (Configure) > Custom Feeds.

This is an example of the Feeds view.

S NETWITNESS igate d U Hosts  Files  Dashboard e (o
LIVE COMTENT 5 CRIPTIONS CAPTURE POLICIES INCIDENT RULES INCIDENT NOTIFICATIONS 5 CUSTOM FEEDS
+ [

O Name Trigger Disk Usage Created Last Run Time Status Progress

O TEST Once - 2019-07-1313:30:36  2019-07-13 12:30:36  Completed e

| TEST2 Once - 2018-07-1313:50:33  2019-07-13 13:50:32  Completed e

O te Once - 2019-07-14 04:16:31 2018-07-14 04:16:51 Completed CEE——

| onlydom Once - 2012-07-14 04:21:37  2019-07-1404:21:37  Complered e

O PCAP Once - 2019-07-1409:30:49  2019-07-14 02:30:42  Completed e

The Feeds tab has a toolbar and a grid.
Toolbar

This table describes the options in the toolbar.
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=%

» @ N

Feeds Grid

Initiates the creation of a custom or identify feed by displaying the Setup Feed dialog is displayed.

Setup Feed

(® Custom Feed

() Identity Feed

Cancel
o Custom Feed opens the Configure a Custom Feed wizard.
o |dentity Feed opens the Configure Identity Feeds wizard.

Deletes the feed that you selected.

Opens the Configure Custom Feed or Configure Identity Feed wizard for the feed that you selected

(see Editing a Feed.

Start or resume data feed.

Stop or pause data feed.

This table describes the columns in the grid.

T

Selects a feed.

Name Name of the feed.
Note: You can now use special characters to define the name of the custom feed.
Trigger Displays how often the feed runs which is determined by what you defined in Feed Task Type when
the feed was created.

Created Displays date and time when the feed was created.

Disk Usage Displays the MongoDB storage size used by the TAXII feed.

Last Run Displays date and time when the feed was last run.

Time

Status The status of the feed.

Progress Progress bar.
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Live Resource View

The Live Resource View shows a detailed view of a selected resource, and has the following options:
e Download the resource.

* Subscribe or unsubscribe the resource.

* Deploy the resource to services.

» Locate services on which the resource is deployed and remove the resource from services.

The required permission to access this view is View Live Resource Details.

To access this view, do one of the following:
1. Goto (Configure) > LIVE CONTENT > Search Criteria.

2. In the Live Search view, Detailed Results, click the resource type icon or the resource name.

3. In the Live Search view, Grid Results, double-click a resource or select a resource and click Details.

This is an example of the Resource view.

.
.li:';' NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports admin

LIVE CONTENT SUBSCRIPTIONS CAPTURE POLICIES INCIDEMT RULES INCIDENT NOTIFICATIONS E CUSTOM FEEDS

¥ Download R Subscribe B, Deploy € Service Locator

) Malware Domain List

Feed
2012-02-09 4:48 PM
2017-07-20 12:40 AM

List of domains commonly associated with malware sourced from
www.malwaredomainlist.com

0.1491

79.256 KB

@ threat, malware

The Live Resource View has a detailed view of a single resource and a toolbar.

Resource Details

The following table describes the elements in the Resource Details section.
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Resource
Type Icon

Name

Type
Created
Updated
Description
Version in
production
Size

Required
Resources

Tagged as

L

Required
Meta Keys

Generates
Meta Values

Permissions

A graphic representation of the resource type, for example 1y

The name of the resource, for example, fingerprint_office lua,

The type of resource, for example, RSA Lua Parser,

The date the resource was created, for example, 2013-09-15 02:16 PM.
The date the resource was last updated, for example, 2013-09-15 02:16 PM

The description of the resource, for example, Identifies Microsoft Office 95, 2007 Word, Excel, and
PowerPoint documents,

The version of the resource, for example, 0.1.

The size of the resource, for example, 9-079 KB,

A list of resources on which this resource depends, for example, NetWitness Lua Library. Clicking a
resource replaces the currently displayed details with the details of the one you clicked.

The tags that apply to the resource. In the example, the tags are featured, informational. Clicking a
tag opens the Live Search View with the search narrowed to match resources with that tag.

The meta keys 49 that apply to the resource. In the example, there are no meta keys required. Clicking a

meta key opens the Live Search View with the search narrowed to match resources with that meta key.

The meta values E that the resource generates. In the example, there are no meta values generated.

Clicking a meta value opens the Live Search View with the search narrowed to match resources with that
meta value.

The permissions required for the resource.

Resource View Toolbar

This table describes the Live Resource view toolbar options.

T

Download

This option downloads the resource currently displayed in the Resource
.L Download View_p y cispiay

89
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Subscribe or ; This option subscribes to or unsubscribes from the resource currently
Unsubscribe :-'l-“'i Subscribe displayed in the Resource View.

3 Unsubscribe Clicking Subscribe opens a dialog notifying that you are agreeing to

receive notification when the selected resources are updated. You can
cancel or click OK.

¢ Clicking Unsubscribe asks for confirmation that you want to stop
receiving notification when the selected resources are updated. You
can then choose to cancel or you can click Unsubscribe or
Unsubscribe and Remove, which also removes the resource from
services on which it is deployed.

Deploy @’ Deploy This option provjdes away to deploy the resource currently displayed in
the Resource View. Clicking Deploy opens the Manual Resource
Deployment dialog.

Service Locator ¢ seryice Locator 1 Nis Option displays a list of services on which the currently displayed
resource is deployed. You can remove the resource from all services or
selected services.
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Live Search View

The Live Search view provides the ability to browse the configured Live CMS for resources. Once
matching resources are found, you can view details, subscribe to resources, and deploy resources to
services and service groups.

This is an example of the Search view.

o
,:-,‘ NETWITNESS 3 Users osts iles re s admin v
LIVE CONTENT RIPTIONS € o s S INCIDENT NOTIFICATIONS \ RULES  CU v OG PARSER RULES
Search Criteria Matching Resources
Keywords =l show Results @ | Details [, Deploy 3 Subscribe | 3 Package ©
malware O subscribed Name Created Updated Type Description
Category M yes Malware Domains 2012-02-08 4:48 PM 2017-07-211:02 AM Feed List of domains associ
[CJFEATURED O yes P List
» CITHREAT O no Domain List
» CJIDENTIT O yes F
» CIASSURANCE O ne M:
» CJ OPERATIONS L e M
O no M ity Unidentified
Resource Types
O no M:
O no SchoolBel Application Rule The SchaolBell rule deu
Medium O no Flame on FlexParser Legacy: Intended only f
¥ O no RS h Command ... Feed
O no RSAFi h Command .. Feed
Required Meta Keys
O no Dreambot Malware Application Rule The Dreambot is 2 bank
O no Application Rule Detects malicious outb
Generated Meta Values |- — — - —
57 Matching Resources

The Live Search view has a panel for specifying search criteria and a panel that displays matching
resources. The Search Criteria panel is collapsible to provide more width for viewing the Matching
Resources panel.

Search Criteria Panel

This is an example of the Search Criteria panel.

Search Criteria

Keywords

» CITHREAT

» CJIDENTITY
» CJASSURANCE
» CJOPERATIONS

Resource Types

Medium

Required Meta Keys

Generated Meta Values

The following table provides descriptions of the Search Criteria panel features.
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Keyword(s)

Category

Resource Types

Enter a keyword or keywords to browse for resources that have the keyword in the resource
name or the resource description. You can use wildcards when you enter a keyword.

The categories mirror the hierarchical Investigation Model that NetWitness uses to organize
resources. The purpose of the Investigation model is to deliver an accurate path to information

security incident response. For more information, see the [nvestigation Model topic in the
NetWitness Content space on NetWitness Community.

Select resources types from the drop-down list to filter resources by type of resource. Possible
values are:

¢ Advanced Analytics (Warehouse)
e Application Rule

e Bundle

e Correlation Rule

* Event Stream Analysis Rule
e Feed

e FlexParser

¢ Investigation Column Group
* Investigation Meta Group

¢ Investigation Profile

¢ Log Collector

e Log Device

e Lua Parser

¢ Malware Rules

e NetWitness List

e NetWitness Report

e NetWitness Rule

e (Version 11.5 and later) Health and Wellness Dashboards

e (Version 11.5 and later) Health and Wellness Monitors

Note: Some rules that have been deployed to an earlier version of NetWitness may not deploy or

execute on NetWitness 11.x. For more information, see the Troubleshooting Live Services.
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Medium

Tags

Required Meta
Key(s)

Generated Meta
Value(s)

Research
Created Date

Research
Modified Date

Search

Cancel

Include
Discontinued
Resources

Select one or more mediums from the drop-down list to search for content based on the meta
data source.

Available values for medium are as follows:

* endpoint: for NetWitness 11.3 and later): applied to content that uses meta
derived from endpoint agent and endpoint server data

* log: applied to content that uses meta derived from log data
e packet: applied to content that uses meta derived from network packets

* log and packet: applied to content that correlates meta derived across log and
packet data

Select meta tags from the drop-down list to browse based on how the meta is tagged. For example, to
browse resources for a Log Decoder, select the netwitness for logs tag. Alternatively, you can click a
tag in the Matching Resources panel to insert that tag in this field.

Enter a specific meta key; for example, threat.source, Alternatively, you can click a meta key in the
Matching Resources panel to insert that tag in this field.

Enter a generated meta value; for example, netwitness, Alternatively, you can click a generated meta
key in the Matching Resources panel to insert that tag in this field.

Specify a date range during which resources were created. For example, to browse resources that were
created between January 1 and January 4, you select January 1 as the start date and January 4 as the
end date. You must enter dates in mm/dd/yyyy format or you click and pick dates from a calendar.

Specify a date range during which resources were modified. For example, to browse resources that
were modified between January 1 and January 4, you select January 1 as the start date and January 4 as
the end date. You must enter dates in mm/dd/yyyy format or you click and pick dates from a

calendar.

Click Search to send the search request to the Live server. More specific search criteria return
matching resources more quickly.

Click Cancel to cancel the search in progress.

Check Include Discontinued Resources to include the discontinued resources in the search
result. For an up-to-date list of resources that have been discontinued, see the Discontinued
Content topic.

Matching Resources Panel

The Matching Resources panel displays search results based on the selections made in the Search
Criteria panel. Results are initially displayed in a grid, but you can switch between two Show Results
options: Detailed or Grid.

Detailed Results

In the detailed results, you can click a tag, meta key, or resource meta value to auto fill the Search
Criteria panel and pivot the search results.

The following table describes the elements in the detailed results.
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Resource
Type Icon

Name

Type
Updated
Version
Size

Subscribed

Description

Tags

Meta Keys

Resource
Meta Values

Grid Results

5

The name of the resource, for example, Group Management.

A graphic representation of the resource type. For example

Note: (Discontinued) is displayed next to the resource name if a resource is discontinued.

The type of the resource, for example, Rule.

The date when the resource was last updated, for example, 2015-09-15 4:27 PM.
The version of the resource, for example, 0.1.

The size of the resource, for example, 153 B.

Subscription status:

¢ yes: This NetWitness instance is subscribed to this content resource.

¢ no: This NetWitness instance has not subscribed to this content resource.

The description of the resource, for example, Compliance Rule-Group Management.

The tags that apply to the resource. Clicking a tag narrows the search to resources with that tag. For

L

example, .

The meta keys that apply to the resource. Clicking a meta key narrows the search to resources with

£

that meta key. For example, .

The meta values generated by the resource. Clicking a meta value narrows the search to resources

that generated the meta value. For example, E .

In the grid view, you can select one or more resources and use additional options in the toolbar to view
the details of a single resource, subscribe to resources, and deploy resources.

The following table describes the elements in the grid results.

e

Subscribed

Name

Created

Updated

Subscription status:
¢ yes: This NetWitness instance is subscribed to this content resource.

e no: This NetWitness instance has not subscribed to this content resource.

The name of the resource, for example, Group Management.

Note: The resource name is displayed in red color if it is discontinued.

The date when the resource was created, for example, 2015-08-12 3:11 PM,

The date when the resource was last updated, for example, 2015-09-15 4:27 PM,

Deploy Content

94



Live Services Management Guide

e o

Type The type of the resource, for example, Rule,

Discontinued The status of the discontinued resources:
¢ yes: The resource that matches the search criteria is discontinued

e no: The resource is not discontinued

e --: The Live Server is not checked for the discontinued resources

Description The description of the resource, for example, Compliance Rule-Group Management.
Toolbar

Show Resuli This menu offers two ways to view search results: Detailed and Grid.,

Detzils This option applies to a single selected resource. Clicking Details opens the selected resource in the Live
Resource view.

E: Deploy This option applies to one or more selected resources.

2 Subscribe This option applies to one or more selected resources. Clicking Subscribe opens a dialog that
: asks for confirmation that you want to receive notification when the selected resources are
updated.

x Package This menu offers two packaging functions for the selected resources:

e Create: creates a resourceBundle.zip file that contains the selected resources and opens a
dialog in which you can either:

e open the file, or
¢ save the file for subsequent deployment.

¢ Deploy: opens the Deployment Wizard, in which you can choose a resourceBundle.zip file
and deploy it.

See Also

* For more information on Deployment ( | Deplay ), see Find and Deploy Live Resources.

* For more information on Deploying a Package (x Package ), see the Resource Package
Deployment Wizard,.
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Live Search Content View

The Live Search Content view provides the ability to search the configured Live CMS for content. Once
matching content are found, you can view the details, and download the content.

This is an example of the Search Content view.

NETWITNESS

& Content

View New, recently updated and community content details here.

SOURCE

NetWitness

Content Showing New Content (12) Timezone : GMT+0530 Asia/Calcutta

NAME } CREATED * UPDATED & TYPE & MIN PLATFORM VERSION 4 DESCRIPTION

O New

Recently Updated 07-Sep-2022 18:... 07-Sep-2022 18:... Application Rule LG Detects a Windows command and scripting interpreter exe.

30-Aug-202218:..  30-Aug-202223..  Application Rule 115 Identifies User Account Control (UAC) bypass attempts usi..
Search Content
26-Aug-202219...  26-Aug-202219..  EventStreamAn... 115 When attempting to access 0365 environments, actors ma.
25-Aug-202222:..  25-Aug-202222..  Application Rule Al Versions In environments where admin privileges have already been. |
25-Aug202222:..  25-Aug-202222..  ApplicationRule Al Versions C2 communication for Quasar RAT uses a common SSL Cer..
25-Aug-202216...  25-Aug-202216..  Application Rule All Versions This rule helps to detect regsvr32.exe, rundii32.exe, and diIl.
25-Aug-202216...  25-Aug-202216..  Application Rule All Versions fodhelper (Features On Demand Helper) is an executable u..
25-Aug-202216....  25-Aug-202216:..  Application Rule All Versions Raspberry Robin, the LNK Worm, is commonly known tod...
25-Aug-202216:...  25-Aug-202216..  Application Rule Al Versions Adversaries can use the command prompt feature cmd/R <.
19-Aug-202222..  19-Aug-202222..  Application Rule Al Versions WhisperGate, a type of data wiping malware, is commonly ...

19-Aug-2022 22... 19-Aug-2022 22-... Application Rule Al Versions Towards it's final execution steps, WhisperGate, the data w..

19-Aug202222...  19-Aug202222..  Application Rule Al Versions WhisperGate, a type of data wiping malware, is commonly ..

NETWITNESS

&) Content

SOURCE: | Community View , recently updated and community content details here.

Only Opensource
Showing Filtered Content (2) Timezone : GMT+0530 Asia/Calcutta
Content
NAME } CREATED * UPDATED & TYPE & MIN PLATFORM VERSION 4 DESCRIPTION }
New

O Recently Updated v 19-Aug202222..  19-Aug-202222..  ApplicationRule NA Data Wiping Malwares may partially or completely overwr...

Search Content 18-Aug-2022 21:... 18-Aug-2022 21.... Application Rule Detects a successful ProxyShell exploitation attack (CVE-2...|

The Live Search Content view has a panel for selecting the source and specifying search content. The
matching content are displayed on the right panel.

The following table provides descriptions of the Live Search Content panel features.

Description

NetWitness Select NetWitness from the Source drop-down menu to search for in-built content that
NetWitness Platform Live provides.

Community  Select Community from the Source drop-down menu to search for the content
collected and retrieved from third party and open source communities.
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Only Select the Only Opensource checkbox to retrieve the content from the open-source
Opensource  communities.

Note: When the community is selected as the source, the Only Opensource option
will be displayed under the Search Content Panel to select and search for open
source-related content.

New Select New to retrieve the content which is created in the last 21 days.
Recently Select Recently Updated to retrieve the content which is updated in the last 21 days.
Updated

Search Content Panel

This is an example of the Search Content panel.

The following table provides descriptions of the Search Content panel features.

N

Keywords Enter a keyword or keywords to browse for content that have the keyword in the
resource name or the resource description. You can use wildcards when you enter a
keyword.

97



Live Services Management Guide

o o

Resource Select resources types from the drop-down list to filter resources by type of resource.
Types Possible values are:

* Application Rule

e Feed

e Log Device

e Correlation Rule

e NetWitness Rule

e NetWitness Report

e Lua Parser

e Log Collector

e NetWitness List

e Malware Rules

» Event Stream Analysis Rule

e Advanced Analytics (Warehouse)
e Bundle

e Health and Wellness Dashboards
» Health and Wellness Monitors

* Investigate Profile

e Investigate Column Group

» Investigate Meta Group
Mediums Select one or more mediums from the drop-down list to search for content based on
the meta data source.
Available values for medium are as follows:
» endpoint: for 11.3 and later): applied to content that uses meta derived from
endpoint agent and endpoint server data

» log: applied to content that uses meta derived from log data
o packet: applied to content that uses meta derived from network packets

 log and packet: applied to content that correlates meta derived across log and
packet data.

Tags Select meta tags from the drop-down list to browse based on how the meta is tagged.
For example, to browse content for a Log Decoder, select the netwitness for logs
tag.
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Platform Select one or more platform versions from the drop-down list to search for content
Versions based on the versions. For example, 11.5.

Required Enter a specific meta key. For example, threat.source,

Meta Keys

Generated Enter a generated meta value. For example, rsa-firstwatch.

Meta Values

Created Date  Specify a date range during which content were created. For example, to browse
content that were created between January 1 and January 4, you select January 1 as
the start date and January 4 as the end date. You must enter dates in yyyy/mm/dd
format or you click B and pick dates from a calendar.

Modified Date Specify a date range during which content were modified. For example, to browse
content

that were modified between January 1 and January 4, you select January 1 as the
start date and January 4 as the end date. You must enter dates in yyyy/mm/dd format
or you click & and pick dates from a calendar.

Search Click Search to send the search request to the Live server. More specific search
criteria return matching content more quickly.

Reset Filter Click Reset Filter to reset the existing search results and displays all the content on
the right panel.

Include Check Include Discontinued to include the discontinued content in the search result.

Discontinued  For an up-to-date list of content that have been discontinued, see the Discontinued
Content topic.

Search Results Panel

The Search Results panel displays search results based on the selections made in the Search Content
panel.

This is an example of the Search Results panel.
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&) Content

View New, recently updated and community content details here.

Showing Filtered Content (877) Timezone : GMT+0530 Asia/Calcutta

NAME # CREATED 4 UPDATED 4 TYPE § MIN PLATFORM VERSION % DESCRIPTION 4 DISCONTINUED %

11-Sep-202001:2... 17-Jul-2022 10:01... Feed All Versions This feed contains IP Address (IPv4 and IPv6) indicators that a... No

26-Nov-2020 16:5... 26-Nov-2020 16:5... Not found 11.5.0.0 This dashboard provides information on various NetWitness P... No

26-Nov-2020 16:5... 26-Nov-2020 16:5... Not found 11.5.0.0 This dashboard provides information on NetWitness Platform ... No

11-Sep-202001:2... 17-Jul-2022 10:01... Feed All Versions This feed contains Non-IP Address, text based indicators like ... No

26-Nov-2020 16:3... 26-Nov-2020 16:3... Not found 11.5.0.0 Amount of Incoming UDP Packets Requested by Endpoint ser... No

26-Nov-2020 16:4... 26-Nov-2020 16:4... Not found 11.5.0.0 Capture is not started on this Decoder service, so packet data... No

06-Aug-2020 20:5... 13-Aug-2020 00:4... Application Rule 11.5.0.0 A hash mismatch may indicate a file has been altered fromiits o... No

23-Dec-2020 16:4... 23-Dec-2020 16:4... Log Device 11.5.00 Log device content for event source AWS Route53 Resolver - ... No

19-Mar-2021 19:3... 19-Mar-202119:3... Log Device 11.5.00 Log device content for event source Cisco Umbrella - cisco_um... No

26-Nov-2020 16:2... 26-Nov-2020 16:2... Not found 11.5.00 Reporting Engine home directory /var/netwitness/re-server/r... No

26-Nov-2020 16:4... 26-Nov-2020 16:4... Not found 11.5.00 80% of the Contexthub Server's query response cache is in use. No

26-Nov-2020 16:3... 26-Nov-2020 16:3... Not found 11.5.00 Decoder is presently not capturing data. No

The following table describes the elements in the search results panel.

Description

Name The name of the content. For example, Log Parser Pack.

Created The date when the content was created. For example, 04-Aug-2017 15:19:06,

Updated The date when the content was last updated. For example, 29-Sep-
2020 20:27:14.
Type The type of the content. For example, Bundle.
Min Platform Platform version that the content supports. For example, 11.5 and higher.
Version

Note: Min Platform Version is not applicable for Community content.

Description The description of the content. For example, Contains all parser files and log
collection files.

Discontinued The status of the discontinued content:
¢ Yes: The content that matches the search criteria is discontinued

e No: The content is not discontinued

Content Details Panel

In the Search Results panel, you can select any content titles to view the details in the pop-up window
and download the content.

Note: NetWitness provides no assurance related to the quality and accuracy of the content provided by
the third parties and open source communities.
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This is an example of the Content Details panel.

Content Details

NOTE: The following content is collected and derived from third-party, open sources. RSA
[NetWitness] at no times makes claims to the quality and/or efficacy above and beyond the
attestations of the authors of the content itself.

[Community] Malware, Malicious Code and APT Open Source YARA
Rules

ME

Malware Rules

UPDATED

16-Feb-2022 21:40:00

DESCRIPTION

The following corpus of YARA rules focus on the detection, identification, and analysis of various forms and
types of malicious code & content (malware) and in some cases those threat actors/adversaries associated
with their use and proliferation. These YARA rules have been collected from the open-source community and
are being made available to our customers via our NetWitness Live Community capability.

Mediums

None

@ Large files may take longer time to start the download. Close Download

The following table describes the elements in the Content Details section.

Name The name of the content. For example, Log Parser Pack.

Type The type of the content. For example, Bundle,

Created The date when the content was created. For example, 04-Aug-2017 15:19:06,
Updated The date when the content was last updated. For example, 29-Sep-2020 20:27:14.
Description The description of the content. For example, Contains all parser files and log

collection files.

Version on The version of the content. For example, 0.5.

Production

Size The size of the content. For example, 14.96 KB.

Required A list of resources on which this resource depends. For example, NetWitness Lua
Resources Library. Clicking a resource replaces the currently displayed details with the details

of the one you clicked in the pop-up window.
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Tags The tags that apply to the content. For example, threat. Clicking a tag opens the
Live Search Content view with the search narrowed to match content with that tag.

Required The meta keys that apply to the content. For example, Threat Category. Clicking a
Meta Keys meta key opens the Live Search Content view with the search narrowed to match
content with that meta key.

Generated The meta values that the content generates. For example, rsa-firstwatch. Clicking a
Meta Values meta value opens the Live Search Content view with the search narrowed to match
content with that meta value.

Discontinued The status of the discontinued content:
¢ Yes: The content that matches the search criteria is discontinued

¢ No: The content is not discontinued
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Resource Package Deployment Wizard

If you have created a package of resources and saved it on a network drive, you can use the Resource
Package Deployment Wizard to deploy the resources manually to a service or a service group without
subscribing to the resources. NetWitness accepts packages in .nwp files or .zip files.

Deploying resources manually deploys them directly to the services without taking advantage of the
powerful resource management capabilities of NetWitness.

If you want to receive notification and updates for updated resources and be able to easily remove
resources from a service, you must subscribe to resources in the Live Search view and deploy the
resources in the Live Configure view.

Note: Use NetWitness Live to create resource bundles; this is a different application that is not part of
NetWitness. Selecting Package > Create in the Live Search - Matching Resources toolbar displays
the Content Package Tool window. You can choose resources to include in a package and save the
package as a NetWitness Package File.

The required permission to access this view is Deploy Live Resources.

To access this view:

1. Goto (Configure) > Live Content.

& Package ~

2. In the Live Search - Matching Resources toolbar, select > Deploy.

The Resource Package Deployment wizard is displayed.

Resource Package Deployment

Package Resources Services Review Deploy

Resource Bundle Browse

Cancel Next.

Features

The Deployment Wizard has five tabs: Package, Resources, Services, Review and Deploy.
Use Close to exit before you complete the wizard.

When you complete the wizard, NetWitness returns to the Live Resources View.

Package Tab

You use this tab to select a resource bundle from your network in this page.

This is an example of the Package tab, with a resource bundle already selected.
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Resource Package Deployment

Package Resources Services Review Deploy

Resource Bundle  resourceBundle3866217298122437775.zip Browse

Cancel Next

The following table describes the elements in the Package tab.

Resource The input field to specify a resource bundle. You can type a path in this field or search using the

Bundle rows
. < button.

Command Buttons

Browse This button opens a File Upload dialog in which you can browse the local file system and select a
bundle.

Cancel Cancels the deployment and closes the wizard.

Next Displays the next tab of the wizard.

Resources Tab

This tab displays the resources contained in the bundle.

The following figure shows an example of the Resources tab.

Resource Package Deployment
Package Resources Services Review Deploy
Total resources : 2

Resource Names Resource Type Dependency Of
suspicious php put long query RSA Application Rule

APT Domain Intelligence RSA Application Rule

Cancel Next

The following table describes elements in the Resources tab.

Resource Name Displays the name of the resources in the bundle (for example, NetWitness Lua Library),
Resource Type Displays the resource types for the resources in the bundle (for example, RSA Lua Parser)
Dependency Of Displays Resources on which the selected resource depends (for example, AIM lua),

Services Tab

You select the services on which you want to deploy the resources in the bundle.
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The Services tab has two tabs, Services and Groups. These provide a list of services and service groups

4
that are configured in the (Admin) > Services view. The columns are a subset of the columns
available in the Services view. You can select the services or the service groups on which you want to
deploy the resources in the bundle.

This is an example of the Services tab.

Resource Package Deployment

Package Resources Services Review Deploy

O # Name ~ Type

Decoder
Decoder
Decoder

Log Decoder

O

Decoder
Log Decoder
Decoder
Decoder
Decoder
Log Decoder

Log Decoder

O O
W NN RN RN W WY

Decoder

Cancel Previous Next

The following table describes the elements in the Services tab.

Services
D Selects services on which you want to deploy the content. You can select any combination of services and
service groups.
Name Displays the services in your environment on which you can deploy the content.
Host Displays the name of the resource host.
Type Displays the type of NetWitness service.
Groups

D Selects service groups (if you have service groups defined in your environment).

Name Displays the names of the service groups.
Review Tab

Displays the resources and services on which the resources will be deployed.

In this tab, you can do the following:
e Review the content and services before you deploy.

* Initiate the deployment of the resources.

The following figure shows an example of the Review tab.
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Resource Package Deployment

Package Resources Services Review Deploy
Service Service Type Resource Name Resource Type
Decoder suspicious php put long query RSA Application Rule
APT Domain Intelligence RSA Application Rule
Cancel Previous Deploy

The following table describes the elements in the Review tab.

Service Information
Service Displays the services in your environment on which you can deploy the content.
Service Type Displays the type of each NetWitness service (type of host or service).
Resource Information

Resource Name  Displays the name of the resources you have selected (for example, NetWitness Lua Library),

Resource Type Displays the resource types for the resources you have selected (for example, RSA Lua Parser),
Deploy Initiates the deployment of the resources and displays the Deploy page (final page of the wizard).
Deploy Tab

This tab allows you to do the following:
¢ View the progress of the job
¢ Cancel the job

This is an example of the Deploy tab.

Resource Package Deployment

Package Resources Services Review

Service Name Resource Name Status Progress

0of2

Cancel

The following table describes the elements in the Deploy tab.

N

Service Name of the services to which resources are deployed.
Name

Resource Name of the resources.

Name

106



Live Services Management Guide

o Jowamn

Status

Progress

Close
Errors

Retry

Status of the manual deployment.

Progress of the manual deployment in a progress bar. When complete, the bar turns solid green.
Command Buttons

Closes the wizard.

Only displays if NetWitness encountered any errors. Click to display the errors.

Only displays if NetWitness encountered any errors. Click this button to try to deploy the resources
again using the wizard.
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NetWitness Live Registration Portal

The NetWitness Live Registration Portal is a self-service wizard in which customers can set up a Live
account and change or reset the password. A Live account is required to get access to the feeds, parsers,
rules, and other content in NetWitness Live library. To access the portal, go to the following

URL: https://live.netwitness.com/registration.

NETWITNESS

Welcome to RSA Live Registration Portal

Thank you for using RSA NetWitness.
Please sign up here for your RSA Live account to access your subscription content.

Sign Up for Netwitness Live Account @
End User License Agreement

FirstName

THIS SOFTWARE CONTAINS COMPUTER PROGRAMS AND OTHER PROPRIETARY
MATERIAL AND INFORMATION, THE USE OF WHICH IS SUBJECT TO AND EXPRESSLY
CONDITIONED UPON ACCEPTANCE OF THIS END USER LICENSE AGREEMENT (THE
“AGREEMENT").

THIS AGREEMENT IS A LEGALLY BINDING DOCUMENT BETWEEN YOU (MEANING
THE INDIVIDUAL PERSON OR THE ENTITY THAT THE INDIVIDUAL REPRESENTS
THAT HAS OBTAINED THE SOFTWARE AND HARDWARE FOR ITS INTERNAL
PRODUCTIVE USE AND NOT FOR OUTRIGHT RESALE) (THE “CUSTOMER") AND
NETWITNESS (WHICH MEANS (1) RSA SECURITY LLC, IF CUSTOMER IS LOCATED IN
THE UNITED STATES, MEXICO OR SOUTH AMERICA; (Il) THE LOCAL NETWITNESS
SALES AFFILIATE, IF CUSTOMER IS LOCATED OUTSIDE THE UNITED STATES, MEXICO
OR SOUTH AMERICA AND IN A COUNTRY IN WHICH NETWITNESS HAS A LOCAL
SALES AFFILIATE; OR (lll) RSA SECURITY & RISK IRELAND LIMITED OR OTHER
AUTHORIZED NETWITNESS ENTITY AS IDENTIFIED ON THE NETWITNESS QUOTE
OR OTHER NETWITNESS ORDERING DOCUMENT, IF CUSTOMER IS LOCATED
OUTSIDE THE UNITED STATES, MEXICO OR SOUTH AMERICA AND IN A COUNTRY IN
WHICH NETWITNESS DOES NOT HAVE A LOCAL SALES AFFILIATE). Unless
NetWitness agrees otherwise in writing, this Agreement governs Customer's use of the
Software and Hardware, except to the extent all or any portion of the Software or
Hardware is: (a) the subject of a separate written agreement set forth in a quotation

Password

CREATE ACCOUNT

ACCEPT

Click Sign Up For Live. The License Agreement page is displayed, once you agree to the Terms and
Conditions, click Accept: the fields for setting up an account are displayed. These include Contact
Information, and License ID.

The following table lists the contact information section fields and its descriptions:

Parameter Description

First Name Your first name.

Last Name Your last name.

Company The name of your
company.

Email The email address

where you want to
receive notifications
related to the Live
account.
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License ID

Username

Password

This is the License ID
on the (missing or
bad

snippet) > System >
Info page.

Caution:

The license ID on
the NetWitness
must be valid and
must be registered
on the Flexera
Server. If not,
contact NetWitness
Customer Support.

The username used to
sign in to Cloud
Services Live
account. The
username must
contain a minimum of
four characters and a
maximum of 16
characters.

The password for the
Cloud Services Live
account. The
password must
contain minimum of
eight characters and
the maximum length
is 24, with at least
one uppercase, one
lowercase, one
number, and one
special character.
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NetWitness Feedback and Data Sharing

The Live Feedback Activity Log enables you to download the usage data required for Live Feedback.
After you download the Live Feedback data, you can then upload it to share with NetWitness.

QA
The settings for these features are available in (Admin) > System > Live Services view,

in the Additional Live Services section.

Additional Live Services

4
Participation in the Additional Live Services is configured in the (Admin) > System > Live
Services view.

Live Feedback

Note: For NetWitness 11.4.1 and later, this section in the UI has been removed. As of 11.4.1,
NetWitness has created the Customer Experience Improvement Program. For details, see "Configure
the Customer Experience Improvement Program" in the NetWitness System Configuration Guide.

Live Feedback is intended to help improve NetWitness.

Aaoditional Live Services
Live Feedback

R5A collects details about the services you use in your deployment for new features and other improvements to the

platform. Informaticn collected is securely sent to RSA.
[+ Additional Feedback Insights
B

Send additional information to improve feature usage, Learn maore

Once you set up and configure a Live account, usage data is automatically shared with NetWitness and is
protected in accordance with the applicable license agreement. All such data shall be anonymized and
shall not have any Personally Identifiable Information.

Before data is sent to NetWitness, all Personally Identifiable Information is removed. Thus, only
anonymous usage data gets transferred to NetWitness.

For more information, see the "Live Feedback Overview" topic in the System Configuration Guide.

File Reputation

File Reputation service provides instant access to the latest signatures using the RSA Live feed so data is
more relevant, with fewer false positives. With this service, users always have reliable data about the
reputation of files in their NetWitness Endpoint system. In addition to the whitelisting service, it
provides blacklisting information as well.
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File Reputation

¥ Enable File Reputation

This option is used to view reputation
RS54 Live to get the reputation status.

Tore

Mot Connected

status of files. The File Hash infarmation from MetWitness Platform is sent to
Reputation status is leveraged by analysts during investigation of files.Learn
= ¥ X =1 =t ==l
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Troubleshooting Live Services

This section provides troubleshooting instructions for issues faced when using the Live Services module
in NetWitness.

Some Rules Are Invalid for Version 11.x

The rules "NetWitness Incident Management - Alert Details" and "NetWitness Incident Management -
Incident Summary" are not valid for NetWitness version 11.x. Do not deploy these rules to an 11.x
system.

Note: Rules are updated frequently, and the documentation for them is available in the Content space
on NetWitness Community. For the latest information on Rules, see RSA NetWitness Rules.

OutOfMemoryError on Context Hub Server

You may encounter an OutOfMemoryError on Context Hub server, and the service becomes
unresponsive.

If there are any TAXII feeds configured, Health and Wellness raises alerts when the available heap
memory of Context Hub server is critically low. If the status of Context Hub server is Unhealthy because
of low memory, perform the following steps:

1. Make sure that the feeds Start Date is within 180 days.

2. Check if any TAXII feed is consuming too much disk space. A TAXII feed can consume maximum
of 300 MB. If it consumes more disk space, you must reduce the value in the Remove STIX data
older than field under Advanced Options in the Custom Feed Creation Wizard when you edit a
TAXII feeds.

Note: If the issue still persists, you must execute step 3.

3. To decrease the number of parallel threads available for processing STIX:

a. Goto K& (Admin) > Services > Context Hub service > View > Explore.
b. In the tree panel, navigate to enrichment/stix/ config.

c. In the right panel, set the stix-query-scheduler-pool-size field value to 2. By default the value is
5. This setting controls how many number of threads are allowed to process queries for STIX
data at the same time.

d. Set the taxii-poll-scheduler-pool-size field value to 2. By default the value is 5. This setting
controls how many number of threads are allowed to poll TAXII servers at the same time.

e. Restart the Context Hub server.

Troubleshooting Live Connect Threat Data Sharing
This section discusses troubleshooting Live Connect Threat Data Sharing.
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Query Log Retrieval Sample

To retrieve a sample of threat intelligence data sent to Live Connect, you must construct a URL by
setting the following parameters:

¢ sendReport: value is true or false: true to send this report to the Live Connect server. False to
just create the report for viewing. The value defaults to false.

¢ hashValues: value is true or false: true to hash the values as md5/sha256. False to show values in
clear text — should use only for manual viewing. Defaults to false.

o startDate / endDate: Dates for time boundaries for log entries. Format: YYYY-MM-DD
HH:mm:ss

The following is an example of the URL used to retrieve query logs:

https://<server>/admin/liveconnect/force aggregation?startDate=2016-01-
18%2000:00:00&endDate=2016-01-19%2010:10:00&sendReport=false&hashValues=true

System Logging: Debug

To access debug information:
1. Go to (missing or bad snippet) > System > System Logging.
2. Select the Settings tab.

3. In the Package Configuration section, select com > netwitness > platform > server >
liveconnect > service (DEBUG).
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Info

System Logging

Updates -
Realtime Historical setings

Licensing
Ernail Package Configuration

Global Motifications @[ investigation

Legacy Motifications B[ list
B ]lve

B 5 liveconnect

I System Logging

Global Auditing

B service (DEBUG)
Jobs

U LiveConnectClient

Live Services

i LiveConnectloghggregatarService

URL Integration i LiveConnectLogParserService
Context Menu Actions ¥ LiveConnectlogRetrievalService
B malware

Investigation

HTTP Proxy Settings

Package com.rsasmecsaliveconnectservice
NTP Settings Log Level DEBUG v
Dashboard Settings [[] Reset recursively

2 admin | @B English (United States) | GMT+00:00
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Policy-based Centralized Content Management

This chapter covers different topics that lets you configure Policy-based Centralized Content
Management.

e About Policy-based Centralized Content Management

e About Content Library

Migrate Content from Core Services to Content Library

Import Content to Content Library

Create an Application Rule

Edit Application Rule

Delete Application Rule

View Application Rule Details

Create a Network Rule
Edit Network Rule
Delete Network Rule

View Network Rule Details

* About Groups

Create a Group
View a Group
Delete a Group
Edit a Group

¢ About Policies

Create and Publish Policies

Clone a Policy
Delete a Policy
Edit a Policy

View a Policy
Enable Content for a Policy

Disable Content for a Policy

e References
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® Content Library Tab

® Groups Tab

B Policies Tab
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About Policy-based Centralized Content Management

Legacy content management involves deploying and managing content in multiple places in the UL

o Live Content UI: Located under the Configuration interface, this allows a “push” deployment of Live
content to one or more services, but does not provide any management of content once it is deployed

o Service Config Ul: Located under Admin > Services > View Config, this Ul enables you to view,
edit or delete content on individual services.

Policy-based Centralized Content Management is a unified approach to find, deploy, and manage content
through the entire life cycle based on policies that can be assigned to groups of devices. It is a single
location to view, modify and manage the content deployed across all services in the environment.

This approach consists of three elements:

o Groups: A collection of NetWitness services (such as Decoders, Log Decoders, etc.) to assign and
manage content.

» Content Policies: A container of content and subscription settings used to assign and manage content
within a Group.

o Content Library: A local repository of content which resides on the Admin Server and is used to
assign content to policies. This includes both Live and Custom content.

The Content Library contains Live content (synchronized with the Live CMS) and any custom content
you create or import. To deploy, remove or manage content on your services, content is assigned from
the Content Library to a Content Policy. Once that content policy is assigned to a group and Published,
the content changes are put into effect on the services within the group.
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Content Policy Flow Diagram
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Benefits of Policy-based Centralized Content Management:

Add or remove content without repeating the process on each service.

Add content from RSA Live or add your custom content into a single content repository. You can add
content from this repository to a policy.

Add a new service to an existing group to automatically deploy all necessary content.

One-click management of subscriptions and automatic updates

1
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* Provides highly responsive and updated Ul for browsing RSA Live content that can help you with the
following:

® View Live content along with your content policies and click B 6 add content from Live.

B Seamlessly view Live content along with your custom content.

IMPORTANT: It is recommended not to use the Centralized Content Management and Service
Config page or Live Content page simultaneously for managing the content. Using the Service Config
UI to add or modify content can cause the content to become out-of-sync with the Content Policy.

Migrate Content from Core Services to Content Library

The customers who want to use Centralized Content Management, and if their content is already
deployed, a migration process is required.

Note: Existing Live content does not need to be exported or imported. All Live content will be
available in the Content Library and will only need to be added to one or more policies and published
as needed.

This process includes the following steps:

o Make sure that the necessary Live content has been selected and applied to one or more Policies.
o Enable subscriptions for Live content as desired.

» Export any custom content, including Application Rules, Network Rules, Lua Parsers and Log
Parsers.

o Import custom content into the Content Library.
e Apply custom content to one or more Policies.

» Create Groups to which Policies will be assigned.

o Publish Policies to their assigned Groups.

Warning: Initially, when a Policy is published to a Group , all the content which are not included in
the policy will be removed from the services in that Group.

To migrate Application Rules or Network Rules

A
1. Goto (Admin) > Services.
2. Go to Config view of the service where application rule or network rule is deployed.

3. Click either the Application Rule or the Network Rule tab.

Note: The Network Rule tab is only available for Network Decoder services.

4. Select the content to migrate.

5. Click Export to export the selected content or click All to export all the content.

119




Live Services Management Guide

6. Type a file name which contains exported content and import the content to Content Library.

For details on importing content to content library, view Import Content to Content Library topic.

The following table lists the supported file types and file extensions for Application Rules and Network
Rules:

Supported File Types Supported File Extensions

Application Rules NWR NA
Network Rules .NWR NA

To migrate Feeds, LUA Parsers, or Log Devices

The content file locations are as given below:
e Feeds content file location: /etc/netwitness/ng/feeds
¢ Lua Parsers content file location: /etc/netwitness/ng/parsers

* Log Devices content file location: /etc/netwitness/ng/envision/etc/devices

You can upload the files which are copied locally from these locations and import these files to Content
Library.

For details on importing content to content library, view Import Content to Content Library topic.

The following table lists the supported file types and file extensions for Log Devices, LUA Parsers and
Feeds:

Supported File Types Supported File Extensions

Feeds .Zip feed and .token
Log Devices .envision NA
LUA Parsers .Zip Juax, .lua and .flextoken

Note: Any imported content will be treated as custom content. If imported content has the same name
as existing Live content, then it must be renamed upon import. Custom content with the same name
can be overwritten.

To create .envision files

1. Keep all the Log Devices in a root folder in your local drive. For example, "logDevices".

2. From the command prompt, run the python script specified in the NetWitness Community portal with
input argument as the path of the above folder.

Note: The command to run the python script is "python3 pythonscriptname.py inputArg".

3. Once you run the script, a new zip named "nw_content logDevices.zip" is created. This zip file will
contain all the envision files.
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About Content Library

This section contains:

Migrate Content from Core Services to Content Library

Import Content to Content Library

Create an Application Rule

Edit Application Rule

Delete Application Rule

View Application Rule Details

Create a Network Rule

Edit Network Rule

Delete Network Rule

View Network Rule Details

Import Content to Content Library

Before the custom content can be used in policies, it must be imported to the Content Library.

To view the list of supported file types and file extensions for different content types, refer Migrate
Content from Core Services to Content Library topic.

To import content to Content Library

1.

Go to Bl (CONFIGURE) > Policies.

. In the policies panel, click Content.

2
3.
4

In the left panel, click Content Library.

. Depending upon the type of content to be imported, click the following tabs:

o Application Rule
¢ Network Rule

o LUA Parser

¢ Feeds

* Log Devices

Note: Log Devices content should be converted to .envision files before importing.

In the respective content panel, click Import.

In the Import panel, click or drag the file to upload.
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7. Click Overwrite to overwrite content. This is applicable only in case of overriding an already
imported content.

Note: You can overwrite the content if the content name is the same as the custom content.
However, overwriting is not supported if the content name is the same as existing content of the
same type from the live server.

8. Select the medium types.

9. Click Import to complete the import process.

Create an Application Rule

This topic describes the steps to create an application rule.

To create a new Application Rule
1. Go to Bl (CONFIGURE) > Policies.
2. In the policies panel, click Content.
3. In the left panel, click Content Library.
The available rules are displayed.
4. In the application rule panel, click + Create Rule to add an application rule.
5. In the New Create Rule panel, do the following:

¢ Enter a unique rule name. If the name of that application rule is the same as an existing rule, an
error message is displayed.

¢ Enter the condition for the rule.

¢ Select the medium to be applied for the rule.

¢ Select the session data to be applied for the rule.

¢ Select the session options to be applied for the rule.

¢ Enter the meta value for the alert on. This is a mandatory field.

¢ Click Save to save the new application rule.

Edit Application Rule

When you edit the application rule, follow these guidelines:

e You can only edit the custom rules.
e The rule name cannot be edited if the custom rule is assigned to a policy.

o If the custom rule assigned to a policy is edited, then the customer must republish the policy for the
changes to take effect in the service.
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To edit an Application Rule

1. Go to Bl (CONFIGURE) > Policies.

2. In the policies panel, click Content.

3. In the left panel, click Content Library.

4. Select an application rule to edit.

5. Click Edit Rule to edit the application rule.

Delete Application Rule

When you delete the application rule, follow these guidelines:

* You can delete only the custom application rules.

* You cannot delete the application rule if it is associated to a policy. You should first disassociate the
application rule from the policy and then delete it.

To delete an Application Rule

1. Goto (CONFIGURE) > Policies.
2. In the policies panel, click Content.

3. In the left panel, click Content Library.
4. Select an application rule to delete.
5

. Click Delete to permanently delete the selected application rule.

View Application Rule Details

This topic describes the steps to view the application rule details.
To view Application Rule details

1. Goto (CONFIGURE) > Policies.

2. In the policies panel, click Content.

3. In the left panel, click Content Library.
The list of application rules is displayed.

4. Click a row to view details about the selected application rule in the right panel.

The various details of the application rule are displayed.

Create a Network Rule

This topic describes the steps to create a network rule.

123



Live Services Management Guide

To create a Network Rule

1.

Go to Bl (CONFIGURE) > Policies.

2. In the policies panel, click Content.

3. In the left panel, click Content Library.
4.
5
6

Click the Network Rule tab.

. In the network rule panel, click + Create Rule to add a network rule.

. In the New Create Rule panel, do the following:

¢ Enter a unique rule name. If the name of that network rule is the same as an existing rule, an error
message is displayed.

¢ Enter the condition for the rule.

Note: The medium is selected as Packet by default, and it cannot be modified.

¢ Select the session data to be applied for the rule.

* Select the session options to be applied for the rule.
¢ Click Cancel to cancel the operation.

¢ Click Reset to reset the data.

¢ Click Save to save the new network rule.

Edit Network Rule

When you edit the network rule, follow these guidelines:

e You can only edit the custom rules.

o The rule name cannot be edited if the custom rule is assigned to a policy.

« If the custom rule assigned to a policy is edited, then you must republish the policy for the changes to

take effect in the service.

To edit a Network Rule

1.

Go to Bl (CONFIGURE) > Policies.

2. In the policies panel, click Content.

3. In the left panel, click Content Library.
4.
5
6

Click the Network Rule tab.

. Select the network rule to edit.
. Click Edit Rule to edit the network rule.

Delete Network Rule

When you delete the network rule, follow these guidelines:
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e You can delete only the custom network rules.

* You cannot delete the network rule if it is associated to a policy. You should first disassociate the
network rule from the policy and then delete it.

To delete a Network Rule

1. Go to Bl (CONFIGURE) > Policies.
2. In the policies panel, click Content.

3. In the left panel, click Content Library.
4. Click Network Rule tab.

5. Select a network rule to delete.

6

. Click Delete to permanently delete the selected network rule.

View Network Rule Details

This topic describes the steps to view the network rule details.

To view Network Rule details

1. Goto (CONFIGURE) > Policies.
2. In the policies panel, click Content.

3. In the left panel, click Content Library.
4. Click the Network Rule tab.
5

. The list of network rules is displayed.

6. Click a row to view details about the selected network rule in the right panel.

The various details of the network rule are displayed.

About Groups

This section contains:
e Create a Group

* View a Group

* Delete a Group

» Edit a Group

Create a Group

You can create a group with one or more services and assign one policy to it. Groups may be created
without any assigned policy; however, a policy must be assigned to a group and Published in order for
any content changes to take effect.
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To create a Group

1. Go to IBl (CONFIGURE) > Policies.

2. In the policies panel, click Content.

3. In the left panel, click Groups.

4. In the tool bar, click + Create New.

5. In the New Group panel, do the following:
¢ Enter the name of the group.
¢ Enter the description for the group.

6. Click Next.

7. In the Define Group, click + to assign services to the group.

Note: A service is disabled if it is assigned to another group.

8. Click Next.

9. In the Assign Policies, click + to assign policies to a group. You can assign only one policy to any
particular group.

10. Do any one of the following:
¢ Click Save and Publish to save and publish the settings.
°  To publish all the content, click Publish Al
° To publish only the content that is not published on the service, click Publish Changes.
° To cancel the publish content dialog, click Cancel.

¢ Click Save and Close to save the settings.

View a Group

This topic describes the steps to view the properties of Group.
To view the properties of the selected Group

1. Go to Bl (CONFIGURE) > Policies.

2. In the policies panel, click Content.

3. Click Groups. The available groups are displayed.

4

. Click a row to view details about the selected group in the right panel.

Delete a Group

You can delete one or more groups. Once the group is deleted, all services will be removed from the
group and all the policy content will be deleted from the services.
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To delete a Group
1. Go to IBl (CONFIGURE) > Policies.

2. In the policies panel, click Content.
3. Click Groups. The available groups are displayed.
4

. Select one or more Groups and click Delete.

The confirmation message is displayed.

Edit a Group

You can edit the properties of the group at any point in time. The status of the updated group is
unpublished if you change the service or policies in a group. If you just change the group name and
description, then the status remains published (if it is already published).

To edit the selected Group
1. Goto (CONFIGURE) > Policies.
2. In the policies panel, click Content.
3. In the left panel, click Group. The available groups are displayed.
4. Select a group to edit and click Edit.
5. Make the required changes in the group.
6. Do any one of the following:
¢ Click Save and Publish to save and publish the policy.
¢ The policy will be listed under the Unpublished category.

¢ Click Save and Close to save the settings and return to the Policies view.

Note: All the content within a service will be deleted when a service is removed from a group.

About Policies

This section contains:

¢ (Create and Publish Policies

* Clone a Policy
e Delete a Policy
» Edit a Policy

* View a Policy
e Enable Content for a Policy

e Disable Content for a Policy
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Create and Publish Policies

You can create a policy and assign it to one or more groups.

To create a Policy
1. Go to IBl (CONFIGURE) > Policies.
2. In the policies panel, click Content.
3. Click Policies.
The available policies are displayed.
4. Click + Create New to add a new policy.
5. In the New Policy panel, do the following:
¢ Enter a unique policy name.
¢ Enter a description for the policy.
6. Click Next.

7. In the Available Content, select the content type and click + to add the content to the policy. After
you add the content, you can enable subscription (if required) by clicking subscribed toggle. Once the
content is subscribed the updates are pushed automatically.

Note: Subscription is not allowed for custom content.

Note:

- All the dependencies are added automatically for the selected content. You can click on the
content name highlighted in blue and look for details such as content description, content type,
resources and dependencies and so on. You can also add and subscribe the resource from the
details view.
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8. In the Group List, click + to assign groups to the policy.

Note: A group is disabled if another policy of the same type is already assigned to this group.

9. Do any one of the following:
¢ Click Save and Publish to save and publish the settings.
° To publish all the content, click Publish All.
° To publish only the content that is not published on the service, click Publish Changes.

° To cancel the publish content dialog, click Cancel.

Note: While publishing the first policy to a service, all previous content except custom feeds,
will be deleted. Ensure that all custom content are migrated to content library before
publishing the first policy.

¢ Click Save and Close to save the settings.

Note: You can also publish a policy from Policy Details screen. For more information on
publishing a policy from Policy Details screen, refer View a Policy feature.

IMPORTANT:

When first applying a Content Policy to manage content, the existing Live and custom content on the
service (excluding Custom Feeds) will be removed and replaced with the Policy content. You should
compare the existing service content with the policy before applying to ensure required content is
added to the policy. Endpoint risk scoring requires certain application rules. Refer Endpoint Risk
Scoring Rules to view the list of these application rules.

Clone a Policy

When you clone a policy, all the content from the old policy is copied to the new policy. The cloned
policy can be assigned to a new group. You can clone only one policy at a time.
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To clone a Policy

1. Go to IBl (CONFIGURE) > Policies.

2. In the policies panel, click Content.

3. Click Policies. The available policies are displayed.
4

. Select a policy to clone and in the More actions drop-down list in the tool bar, click Clone.

The policy is cloned successfully.

Delete a Policy

Deleting a policy removes all content from the associated group.

To delete a Policy
1. Go to IBl (CONFIGURE) > Policies.

2. In the policies panel, click Content.

3. Click Policies. The available policies are displayed.

4. Select one or more policies and in the More actions drop-down list in the tool bar, click Delete.
The delete dialog is displayed.

5. Click Delete to permanently delete the selected policy.

Deletion will take immediate effect and the policy will no longer be available in any group.

Note:

- The services associated with this policy still require a restart if the restart is pending.

- You can also delete a policy from Policy Details screen. For more information on deleting a
policy from Policy Details screen, refer View a Policy feature.

Edit a Policy

You can edit the content and settings of the policies. Once the policy is edited, the changes in the policy
are reflected upon saving the policy. The changes are applied to the service once published. After saving
and before publishing, the publication status of the changed policy is set to Unpublished if any settings

are changed.

To edit a Policy
1. Goto (CONFIGURE) > Policies.

2. In the policies panel, click Content.
3. Click Policies. The available policies are displayed.
4. Select a policy to edit and click Edit.
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5. Make the required changes in policy.

6. Do any one of the following:

¢ Click Save and Publish to save and publish the policy. The policy will be listed under the
Unpublished category.

¢ Click Save and Close to save the settings and return to the Policies view.

Note: You can also edit a policy from Policy Details screen. For more information on editing a policy
from Policy Details screen, refer View a Policy feature.

View a Policy

This topic describes the steps to view the properties of a Policy.

To view properties of the selected Policy

L.

10.

Go to Bl (CONFIGURE) > Policies.

2. In the policies panel, click Content.

3. Click Policies. The available policies are displayed.
4.
5

Click a row to view details about the selected policy.

. To change the order of application rule assigned to the policy, do the following:

1. To move the application rule or network down the order, click B in the Order column.

2. To move the application rule up the order, click BN in the Order column.

3. You can also manually enter the order number in the Order column.

To change the order of network rule assigned to the policy, do the following:
1. Click Network Rules tab.

2. To move the network rule or network down the order, click ™ in the Order column.

3. To move the network rule up the order, click B in the Order column.

4. You can also manually enter the order number in the Order column.

IMPORTANT: It is recommended not to order application rules or network rules deployed on the
service from Service Config page if the service is part of Centralized Content Management.

To edit the policy, click Edit Policy. For more information on editing a policy, refer Edit a Policy
feature.

To delete the policy, click Delete Policy. For more information on deleting a policy, refer Delete a
Policy feature.

To publish the policy, click Publish Policy. For more information on creating and publishing a
policy, refer Create Policies feature.

To enable or disable subscription, click Subscribe or Unsubscribe respectively.
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Note:
- Subscription is not allowed for custom content.
- The Subscribe and Unsubscribe button is disabled if any one of the content selected is custom.

Enable Content for a Policy

This topic describes the steps to enable the content for a Policy.

To enable content

1. Go tol@l (CONFIGURE) > Policies.

2. In the policies panel, click Content.

3. In the left panel, click Policies.

4. Click the policy name to view the policy details.
5

. In the Application Rule, Network Rule, Feed, Log Device or LUA Parser panel, click the row to
select the content to be enabled. You can either select all content or select any specific content to be
enabled.

6. Click Enable.

Disable Content for a Policy

This topic describes the steps to disable the content for a Policy.

To disable content

1. Go tol@l (CONFIGURE) > Policies.

2. In the policies panel, click Content.

3. In the left panel, click Policies.

4. Click the policy name to view the policy details.
5

. In the Application Rule, Network Rule, Feed, Log Device or LUA Parser panel, click the row to
select the content to be disabled. You can either select all content or select any specific content to be
disabled.

6. Click Disable.

References
This section is a collection of references, which describe the user interface and more detailed information

about how Policy-based Centralized Content Management works in NetWitness. The topics are presented
in alphabetical order.

Content Library Tab

The (CONFIGURE) > Policies view contains two tabs: Configuration and Content.
The CONTENT tab has Content Library, Policies and Groups on the left panel.
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Below is an example of the Content > Content Library tab:

L
"l‘l:“) NETWITNESS

4 Create Rule

HNAML T MEDIUM LAST UPDATED POLICIES

Jremiboad Job

Show next 50 content
15 | Oselected

1 Toolbar

o Create Rule - Lets you create a rule.

2 Rule List Pane

o Name - Name of the rule.
e Medium - Medium through which the rule is created.
o Last Updated - Displays the time when the rule is updated.

o Policies - Policies to which the rule is applied.

You can also sort on any column. If you mouse over a column header, a sort icon is displayed: .

Click the llCOIl to sort by the selected column.

Create New Rule dialog:

Below is an example of the Create new rule dialog:
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LY N =
..J% NETWITNESS

Create New Rule

The table describes the information and options in the Create New Rule dialog:
Field Description
Rule Name Name of the new rule. The name should be unique.
Condition  Condition for the new rule.

Medium Medium through which the rule is created.

Session Session data for the new rule. Indicates if the rule processing should stop, keep, filter or
Data truncate when the session data is running.

Session Session options for the new rule. Indicates if the session options should be alert, forward
Options or transient.

Alert On Conditions for which the alert should be turned on.

Save Saves the settings and closes the Create New Rule dialog.
Cancel Cancels the operations.
Groups Tab

Below is an example of the Content > Groups tab:
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Files Dias

POLICIES INCIDENT R

t Create New

[ GROUP MAME *  DESCRIPTION SERVICES POLICIES POLICY STATUS

The following table describes the Groups tab.

1 Toolbar

o Create New - Lets you create a new group. For more information, see Create a group.

o Edit - Lets you edit the group. For more information, see Managing Groups.

o Publish - Publishes selected groups.

Delete - Deletes the selected group.

2 Group List Pane

Group Name - Name of the group.

Description - Description of the group.

Services - Displays the service to the which the group is applied.

Policies - Displays the policy to which the group is applied.

Policy Status - Status of the policy. The values are: Published, Unpublished, Failed, N/A.

You can also sort on any column. If you mouse over a column header, a sort icon is displayed: l

. Click to sort by the selected column.

3 Groups Details Panel

Displays the properties of the selected group.

Below is an example of the Create group dialog:
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The table describes the information and options in the Create Group dialog:

Field Description

Group Name Name of the group. The name should be unique.

Group Description Description of the group. Description should not exceed 8000
(Optional) characters.

Save and Close Saves the settings and closes the Create Group dialog.

Below is an example of the define group dialog:

The table describes the information and options in the Define Group dialog:
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Field Description

Services List Displays the list of services.
The following describes services list:
Service name — Name of the service.

o Group - Name of the group.
o Host - Host name of the service.
e Version - Service version.

« All - Lets you to add services to the group. You can either click [EE@to add all
services or click @] to add specific service.

Hide Services in  Displays the services that is not assigned to any group. By default, this option is
a Group disabled.

Selected Services Displays the list of selected services for the group.
Save and Close Saves the setting and closed the create group dialog.

Save and Publish Saves and publishes the created group.

Note: This option is disabled if you have not:
- Assigned services.
- Assigned policies.

Below is an example of Assign policy dialog:

Sl
o= NETWITHESS

The following table describes assign policy dialog:

Field Description
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Policies List Displays the list of policies associated with the group.
The following describes policies list:

o Name - Name of the policy.
o Description - Description of the policy.
o Groups - Groups associated with the policy.

o Action - Click to add policies to the group.

Selected Policies Displays the list of selected policies for the group.
Save and Close Saves the setting and closed the create group dialog.
Save and Publish Saves and publishes the created group.

Note: This option is disabled if you have not:
- Assigned services.
- Assigned policies.

Policies Tab

The (CONFIGURE) > Policies view contains two tabs: Configuration and Content.

Below is an example of the Content > Policies tab:

:lt.f NETWITNESS I = 2es ponc Users osts Files

SCRIPTIONS CAPTL LIg POLICIES INCIDENT RULES
CONTENT
{ Create Mew § More Actions

0 MNAME + DESCRIPTION GROUFS POLICY STAT_  LAST UPDATED

None NiA O,

UPDATED

adrmin
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1 Toolbar:

o Create New - Lets you create a new policy. For more information, see Create a policy.

o Edit - Lets you edit the policy. For more information, see Managing Groups.

o Publish - Publishes selected policy or policies.

¢ More Actions:

o Assign to Group --Lets you assign policy to a group.
e Clone - Lets you clone a policy.

o Delete - Deletes the selected group or groups permanently.

2 Policy List Pane:

Name - Name of the policy.

Description - Description of the policy.

Groups - Lists the group to which this policy is applied.

Policy Status - Status of the policy. The values are: Published, Unpublished, Failed, N/A.
Last Updated - Displays the time when the policy is updated.

Updated By - The user who updated the policy. You can also sort on any column. If you

mouse over a column header, a sort icon is displayed: . Click the l icon to sort by the
selected column.

3 Policy Details Panel:

Displays the properties of the selected policy.

Below is an example of the Create Content Policy dialog.
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The table describes the information and options in the Create Policy dialog:

Field Description

Policy Name Name of the policy. The name should be unique.

Policy Description Description of the policy. Description should not exceed 8000
(Optional) characters.

Define Policy Settings:

Field Description
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Available
Content

Selected
Content

Displays the available content resources in your deployment. Click expand the resource
type.

The following describes resource type:
e Name - Name of the resource.
e Medium - Meta data source medium. Available values for medium are as follows:

o Endpoint: applied to content that uses meta derived from endpoint agent and
endpoint server data

o Log: applied to content that uses meta derived from log data
o Packet: applied to content that uses meta derived from network packets

o Log and packet: applied to content that correlates meta derived across log and
packet data

» Created - Displays the time when the resource is created
o Last Updated - Displays the time when the resource is updated last.

e Action- Click + to add the resource and its dependencies to your deployment.

Lists the selected resource.

Additionally, you can subscribe the content. Once the content is subscribed, the content
resources are updated automatically in case of any changes.
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Assign to Group:

Group List  Displays the list of groups associated with the policy. A group is disabled if it is
already assigned to another policy.

o Group Name

o Policies

» Services

e Action
Selected Lists the selected groups. Click Bl to add groups.
Group
Save and Saves the settings and closes the Create Policy dialog.
Close
Save and Saves and publishes the created policy.
Publish

Note: This option is disabled if:
- Policy settings are not customized.
- Policy is not assigned to groups.

Appendix A: Endpoint Risk Scoring Rules

Endpoint risk scoring requires the following content:

» "accesses administrative share using command shell"

o "activates bits job"
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"adds files to bits download job"

"adds firewall rule"

"allocates remote memory"

"antivirus disabled"

"archiving software reads multiple documents"
"autorun debian package mismatch"

"autorun file path not part of debian package"
"autorun file path not part of rpm"

"autorun key contains non-printable characters"
"autorun"

"autorun rpm mismatch"

"autorun unsigned active setup"

"autorun unsigned appinit_dlls"

"autorun unsigned bho"

"autorun unsigned bootexecute registry startup method"

"autorun unsigned explorer registry startup method"
"autorun unsigned hidden"

"autorun unsigned hidden only executable in directory"
"autorun unsigned ie toolbar"

"autorun unsigned in appdatalocal directory"
"autorun unsigned in appdataroaming directory"
"autorun unsigned in programdata directory"
"autorun unsigned in temp directory"

"autorun unsigned logontype registry startup method"
"autorun unsigned Isa provider"

"autorun unsigned servicedlIl"

"autorun unsigned winlogon helper dIl"

"autorun unsigned winsock Isp"

"bad certificate warning disabled"

"blacklisted file"
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e "browser runs command prompt"

e "browser runs mshta"

e "browser runs powershell"

e "builds script incrementally"

 "clears application event log"

o "clears event logs using powershell"

e '"clears security event log"

o "clears setup event log"

o '"clears system event log"

o "combines binaries using command prompt"
e "command line usage of archiving software"
e "command line writes script files"

e "command prompt obfuscation"

e "command prompt obfuscation using value extraction"
e "command shell runs rundI132"

o "completes bits download job"
 "configures image hijacking"

o "configures port redirection"

 '"copies binary over administrative share"

» '"created in last month"

 '"creates browser extension"

» '"creates domain user account"

 '"creates executable in startup directory"
 '"creates local driver service"

 '"creates local service"

» '"creates local task"

 '"creates local user account"

o "creates password-protected archive"
 '"creates recursive archive"

o "creates remote process using wmi command-line tool"
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"creates remote service"
"creates remote task"
"creates run key"

"creates shadow volume for logical drive"

"creates suspicious service running command prompt"

"debian package hash mismatch in important system directory"

"debian package hash mismatch"
"deletes backup catalog"

"deletes firewall rule"

"deletes shadow volume copies"
"deletes shadow volume copies using powershell"
"deletes usn change journal"
"disables event logging service"
"disables firewall"

"disables safe mode"

"disables security service"

"disables startup repair"

"disables uac"

"disables uac remote restrictions"
"disables windows audit policy"
"disables windows defender using powershell"
"downloads binary using certutil"
"drops credential dumping tools"
"dumps dns cache"

"dyld inserted"

"enables cleartext credential storage"
"enables login bypass"

"enables rdp from command-line"
"enables safe mode"

"enumerates arp table"
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e "enumerates available systems on network"
o "enumerates domain account policy"
e "enumerates domain administrators"
o "enumerates domain computers"
n 3 n
e "enumerates domain controllers
o "enumerates domain groups"
e "enumerates domain users"
o "enumerates enterprise administrators"
 "enumerates exchange domain servers"
o "enumerates exchange servers"
e "enumerates ip configuration"
o "enumerates local account policy"
n s 1 n
e "enumerates local administrators
" + b b "
¢ "enumerates local administrators on domain controller
n 1 1 n
o "enumerates local groups
e "enumerates local services"
e "enumerates local users"
o "enumerates logical disk"
o "enumerates mapped resources"
e "enumerates network connections"
» "enumerates primary domain controller"
o "enumerates processes on local system"
» "enumerates processes on remote system"
" . "
¢ "enumerates remote netbios name table
e "enumerates remote resources"
e "enumerates route table"
» "enumerates services hosted in processes"
o "enumerates system info"
e "enumerates trusted domains"

o "evades scanning within windows defender"
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"evasive powershell used over network"
"event viewer executes uncommon binary"
"execute dll through rundll32"

"exports sensitive registry hive"

"extracts password-protected archive"

"file encrypted"

"file hidden"

"file path not part of debian package in important system directory"

"file path not part of debian package"

"file path not part of rpm in important system directory"

"file path not part of rpm"

"file vault disabled"

"floating module and hooking"
"floating module in browser process"
"floating module in os process"
"floating module"

"gatekeeper disabled"

"gets current user as system"

"gets current username and group information"
"gets current username"”

"gets hostname"

"gets remote time"

"gina replacement"”

"oraylisted file"

"hidden and hooking"

"hidden in appdata"

"hidden plist and autorun"

"hidden running as root"

"hooks audio output function"

"hooks authentication function"
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e "hooks crypto function"

» "hooks dnsquery function"

e "hooks gui function"

e "hooks network http function"

e "hooks network io function"

e "hooks ntldr function"

» "hooks registry access function"

e "hooks registry enumeration function"
 "http daemon runs command prompt"

» "http daemon runs powershell"

 "http daemon runs reconnaissance tool"
» "http daemon writes executable"

 "ie dep disabled"

e "ie enhanced security disabled"

 "in appdata directory"

e "in hidden directory"

 "in recycle bin directory"

e "in root of appdatalocal directory"
 "in root of appdataroaming directory"

e "in root of logical drive"

 "in root of program directory"

e "in root of users directory"

 "installs root certificate"

e "in system volume information directory"
 "in temporary directory"

e "in uncommon directory"

 "invalid signature"

o "kext signature validation disabled"
 "lateral movement with credentials using net utility"

o "Id preload"
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"library preferences directory”

"lists anti-spyware products"

"lists antivirus products"

"lists firewall products"

"login bypass configured"

"lua disabled"

"mac firewall disabled"

"malicious file by reputation service"

"maps administrative share"

"maps ipc$ share"

"misleading file extension"

"modifies file associations"

"modifies image file execution for persistence"
"modifies registry using command-line registry tool"
"modifies run key"

"modifies shell-open-command file association"
"modifies startup folder location"

"modifies winlogon dll for persistence"
"modifies winlogon registry settings"

"mshta runs command prompt"

"mshta runs powershell"

"mshta runs scripting engine"

"mshta writes executable"

"network access"

"no antivirus notification disabled"

"no firewall notification disabled"

"non-microsoft modifies bad certificate warning setting"

"non-microsoft modifies firewall policy"
n ' 3 5 3 "
non-microsoft modifies internet zone setting

"non-microsoft modifies lua setting"
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» "non-microsoft modifies registry editor setting"
e "non-microsoft modifies security center config"
» "non-microsoft modifies services imagepath"

e "non-microsoft modifies task manager setting"
e "non-microsoft modifies windows system policy"
e "non-microsoft modifies zone crossing warning setting"
* "no uac notification disabled"

e "no windows update notification disabled"

« "office application crashed"

o "office application injects remote process"

« "office application runs bits"

o "office application runs command prompt"
 "office application runs powershell"

o "office application runs scripted ftp"

« "office application runs scripting engine"

o "office application runs task scheduler"

« "office application runs wmi scripting engine"
o "office application writes executable"

o "opens browser process"

o "opens os process"

» "opens process"

o "opswat reported infected"

o "opswat reported suspicious"

e "os process runs command shell"

 "packed and autorun"

o "packed and network access"

o "packed"

o "performs scripted file transfer"

e "possible login bypass"

o "possible mimikatz activity"
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"possible rdp session hijacking"

"possibly configures uac bypass"
"possibly renamed net.exe detected"
"potential abuse of odbcconf"

"potential outlook exploit"

"powershell command using string manipulation"
"powershell injects remote process"
"powershell opens Isass process"
"powershell runs command prompt"
"powershell runs scripting engine"
"process authorized in firewall"

"process redirects to stdout or stderr"
"process with matched yara rule"

"process with opswat reported infected"
"process with opswat reported suspicious"
"psexesvc runs powershell"

"psexesvce runs scripting engine"
"psexesvc runs shell commands"

"pubprn detection”

"queries cached kerberos tickets"

"queries processes on local system"
"queries processes on remote system"
"queries registry using command-line registry tool"
"queries terminal sessions"

"queries users logged on local system"
"queries users logged on remote system"
"record screen captures using psr tool"
"registers always install elevated policy"
"registers appcert dll"

"registers appinit dIl"
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» '"registers boot execute"

o "registers Isa authentication package"
 '"registers lsa notification package"

o "registers Isa security package"

« '"registers netsh helper dIl"

o "registers port monitor dll"

 '"registers shim database"

o "registers startup during safe mode boot"
 '"registers time provider dIl"

o "registry tools disabled"

o "regsvr32 creates windows task"

e "regsvr32 runs powershell"

e "regsvr32 runs rundll32"

o "regsvr32 writes executable"

» "remote directory traversal"

e "removes windows defender definitions"
 "rpm hash mismatch in important system directory"
e "rpm hash mismatch"

» "rpm ownership changed"

e "rpm permissions changed"

e "rundll32 creates windows task"

e "rundll32 runs powershell"

» "runkey persistence"

e "runs acl management tool"

 "runs active directory service query tool"

» "runs binary located in recycle bin directory"
 "runs binary located in root of logical drive"

» "runs binary located in root of program directory"
 "runs binary located in root of users directory"

» "runs binary located in system volume information directory"
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"runs blacklisted file"

"runs certutil with decode arguments"
"runs certutil with encode arguments"
"runs certutil with hashfile arguments"
"runs chained command shell"

"runs chmod"

"runs credential dumping tools"

"runs curl"

"runs ditto"

"runs dns lookup tool for txt record"
"runs dns lookup tool"

"runs file attributes modification tool"
"runs file transfer tool"

"runs forfiles.exe"

"runs graylisted file"

"runs ifconfig"

"runs kextload"

"runs kextstat"

"runs launchctl"

"runs malicious file by reputation service"
"runs mshta with http argument"
"runs mshta with script argument"
"runs msiexec with http argument"
"runs netstat"

"runs network configuration tool"
"runs network connectivity tool"
"runs one letter executable"

"runs one letter script"

"runs ping"

"runs powershell bypassing execution policy"
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 "runs powershell decoding base64 string"

o "runs powershell defining function"

 "runs powershell downloading content”

e "runs powershell invoke-mimikatz function"
 "runs powershell memory stream function"

e "runs powershell"

o "runs powershell shellexecute function"

e "runs powershell using encoded command"
 "runs powershell using environment variables"
e "runs powershell with hidden window"
 "runs powershell with http argument"

e "runs powershell with long arguments"
 "runs psexec on remote system and silently accepts user license"
e "runs psexec on remote system as system user"
e "runs ps"

e "runs registry tool"

 "runs regsvr32 com scriplets"

e "runs regsvr32 using one letter dll"

 "runs regsvr32 with http argument"

e "runs regsvr32 without arguments"

 "runs remote execution tool"

e "runs remote powershell command"

 "runs robocopy.exe"

o "runs rundll32 using one letter dIl"

 "runs rundll32 with http argument"

o "runs rundll32 with javascript argument"
 "runs rundll32 without arguments"

o "runs scripting engine in batch mode using execution engine argument"
 "runs scripting engine"

¢ "runs service control tool"
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"runs shim database installer"

"runs sh"

n b 3 1 n
runs suspicious file by reputation service

"runs tar"

n n
runs tasks management tool

n 1A
runs unzip

"runs waitfor.exe"

"runs wmi command-line tool"

"runs wmi scripting engine"

"runs xcopy.exe"

"safari fraud website warning disabled"

"scripting addition in process"

"scripting engine injects remote process"

n 5 : M n
scripting engine runs powershell

" M : M n
scripting engine runs regsvr32

"scripting engine runs rundll32"

"self signed"

n 5 5 : "
services in programdata directory

"services runs command shell"

"smartscreen filter disabled"

"starts local service"

"starts rdp service"

"starts remote service"

"stops diagtrack service"

"stops error reporting service"

"stops security service"

"stops windows update service"

"sudo no password prompt"

"suspicious file by reputation service"

"suspicious regsvr32.exe task"
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 "system integrity protection disabled"

o "system restore disabled"

o "tampers with windows defender registry"

o "task manager disabled"

 "tasks in programdata directory"

o "terminates process"

 "transfers file using bits"

e "uac disabled"

e "unexpected csrss.exe parent"

o "unexpected explorer.exe destination location"
o "unexpected explorer.exe parent”

o "unexpected explorer.exe source location"

» "unexpected lsass.exe parent"

o "unexpected Ism.exe parent”

» "unexpected msdtc.exe parent"

o "unexpected os process destination location"
o "unexpected os process source location"

o "unexpected runtimebroker.exe parent”

» "unexpected services.exe parent"

o "unexpected smss.exe parent"

e "unexpected svchost arguments"

o "unexpected svchost.exe parent"

» "unexpected taskhostw.exe parent"

o "unexpected wininit.exe parent"

» "unexpected winlogon.exe parent"

e "unknown segment"

o "unsigned copies self"

o "unsigned creates remote thread and file hidden"
e "unsigned creates remote thread"

e "unsigned cron job"
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"unsigned deletes self"

"unsigned kext"

"unsigned library in suspicious daemon"

"unsigned module in signed process"

"unsigned reserved name"

"unsigned runs python"

"unsigned writes executable"

"unsigned writes executable to appdatalocal directory"
"unsigned writes executable to appdataroaming directory”
"unsigned writes executable to library application support directory"
"unsigned writes executable to library directory”

"unsigned writes executable to library preferences directory"
"unsigned writes executable to scripting additions directory”
"unsigned writes executable to system directory"

"unsigned writes executable to var directory"

"unsigned writes executable to windows directory"
"unsigned writes to autorun"

"uses libnss"

"uses libpcap"

"uses mach injection"

"uses mach override"

"warning on post redirect disabled"

"windows firewall disabled"

"windows task runs powershell"

"windows update disabled"

"wmic remote node activity"

"wmiprvse runs command shell"

"wmiprvse runs powershell"

"wmiprvse runs scripting engine"

"writes blacklisted file"
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o "writes executable to recycle bin directory”

o "writes executable to root of logical drive"

o "writes executable to root of program directory"
o "writes executable to root of users directory"

» "writes executable to system volume information directory"
o "writes graylisted file"

o "writes malicious file by reputation service"

o "writes suspicious file by reputation service"

« '"yara rule matched"

» "executable in ads"

 "explorer public folder dll load"

o "powershell double base64"

 "outbound from windows directory"

e "outbound from unsigned temporary directory"
e "unsigned opens Isass"

e "outbound from unsigned appdata directory"
 "rdp launching loopback address"

o "autorun invalid signature windows directory"

o "command shell copy items"
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